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Preface 
This manual provides installation, setup and operating instructions for 360 Systems’ Image 

Server 2000™ and the Multi-Format Image Server, which includes DV and graphics capability.  It is 
organized to provide quick access to topics of primary interest.  An extensive Table of Contents is 
provided at the beginning, and a subject Index at the end, to assist in locating information. 

If you have already used hard disk video servers (or VTRs), you may find discussion of the 
basic server to be covering familiar topics.  However, it is strongly recommended that engineering 
managers and staff members operating the Image Server  read through this manual.  Being familiar 
with its operation can prevent operational mistakes, and will make all users aware of important set-
up and maintenance issues.  

Software and Operations Manual Revisions 
Software revisions are released from time-to-time that introduce new product features, or improve the 
performance of the product.  When such revisions are shipped in the form of a CD-ROM, printed 
operational notes will be included.  When revisions are introduced in the course of product 
production, an updated Operations Manual will be shipped with new servers.   

The title page of an Operations Manual indicates its revision number, which should always match 
the software revision of the server with which it is used.  Operations Manuals for the latest revision 
may be obtained from 360 Systems Customer Service, or from 360 Systems’ web site. 

Definitions 
For the purposes of this manual, “GPI” is defined as “General Purpose Interface,” with associated 
inputs (GPI Inputs) and outputs (GPI Outputs). 
 

Typographical Conventions 
The following typographical conventions are used to clarify meaning: 

Connector or indicator labeling that appears on the unit is shown in Arial Narrow Bold. 
GUI menu items are shown in Arial Bold. 
GUI sub-menu paths are shown by the > symbol. 
 

Feedback on this Manual 
Your comments are welcome.  If anything in this manual seems unclear, please let us know by 
sending an email to support@360systems.com. 
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Safety Notices 

Safety Terms and Symbols 

THE FOLLOWING WARNING SYMBOLS ARE USED IN THIS MANUAL: 

ENGLISH ATTENTION:  REFER TO OWNER’S MANUAL FOR IMPORTANT 
INFORMATION. 

FRANÇAIS ATTENTION:  VEUILLEZ VOUS RÉFÉRER AU MODE D’EMPLOI 
POUR UNE INFORMATION IMPORTANTE. 

ITALIANO ATTENZIONE:  FATE RIFERIMENTO AL MANUALE PER 
INFORMAZIONI IMPORTANTI. 

 

ESPAÑOL ATENTCION:  FAVOR DE REFERIR AL MANUAL DE 
OPERACION POR INFORMACION IMPORTANTE. 

 

ENGLISH WARNING:  ELECTRICAL SHOCK HAZARD. 
FRANÇAIS AVERTISSEMENT:  DANGER DE CHOC ÉLECTRIQUE. 
ITALIANO AVVERTIMENTO:  PERICOLO DI SHOCK ELETTRICO. 

 

ESPAÑOL ADVERTENSIA:  PELIGRO DE CHOQUE ELECTRICO. 

General Safety Caution 
Heed the following important cautions regarding the Image Server in order to avoid personal 
injury or equipment damage. 

Only qualified personnel should perform installation and service.  Refer to appropriate sections 
of this product manual for instruction.  Contact 360 Systems Customer Support for further 
explanation, or to clarify any uncertainty. 

Disconnect the power cord before removing the cover. 

Personal Injury Precautions 
To avoid electric shock, do not operate this product with covers removed. 
To avoid risk of fire, replace the power cord only with same type and rating as specified.  Replace 
damaged power cords immediately. 
This product is grounded through the grounding conductor of the power cord.  To avoid electric 
shock, do not remove or modify the contacts on the plug. 
Prevent the power cord from being walked on, pinched, or abraded. 
To reduce the risk of fire or electric shock, do not expose this unit to rain or moisture. 
Remove jewelry, such as rings, watches, or necklaces before servicing this equipment. 
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Product Damage Precautions 
Image Server recorders contain hard disk drives and other fragile electronic and mechanical 
devices.  While this product is very reliable, it is still vulnerable to shock.  Handle it with care, 
and exercise caution not to drop or bump the recorder as damage to internal components may 
result.  Turn off power before moving the server. 

Do not obstruct air vents.  Maintain an ambient temperature below 30°C (86°F). 

Clean only with a soft cloth dampened with water.  Do not spray cleaners or solvents directly on 
the product. 

CAUTION: Replace only with the same, or equivalent, battery type.  BR and CR Lithium batteries 
are safe for disposal in municipal waste.  Batteries should be fully discharged prior to disposal. 

CAUTION: Never use the power supply switch to shutdown the Image Server.  Doing so may 
cause errors in the hard disk array.  Should this happen, the array can be reinitialized without 
any data loss; however, the process may take several hours.  Shutdown the system only by 
momentarily pressing the front panel power button, or through the On-Screen user interface. 

Product Registration 
Important – As the owner of new capital equipment, you will want to take advantage of the product 
information, enhancements, upgrades, or notifications issued by 360 Systems.  Send in your 
Warranty Card so 360 Systems can remain in contact with you.  Mail or fax it to 360 Systems offices 
in the USA at the address given below. 

Product Improvements and Upgrades 
360 Systems reserves the right to make changes and/or improvements to its products without 
incurring any obligation to incorporate such changes or improvements in units previously sold.  
Certain features mentioned in this document may not be present in all models.  Image Servers are 
not offered for sale in all countries. 

Trademarks 
Image Server 2000, Multi-Format Image Server, 360 Systems, 360 Systems Broadcast, Bit-for-Bit, and 
Direct Digital Import are trademarks or registered trademarks of 360 Systems in the U.S. and/or 
foreign countries.  Other trademarks referred to in this document are the property of their respective 
owners. 

Software Copyrights 
Software in this product is based on the work of, or is copyright by, 360 Systems, SuSE® GmbH, 
Montavista, Trolltech, and FreeType Team.  Copyright 2003-2005 by 360 Systems. 

Video and Audio Copyright Reminder 
It is illegal to use this product to make copies of copyrighted material without the express permission 
of the copyright holder. 
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Introduction 
360 Systems’ Image Server 2000™ and Multi-Format Image Server are multi-stream video 

recorder/servers designed for television broadcast, production, and Pro-AV applications. Image 
Servers can play three independent v ideo streams at once, and store up to 170 hours of MPEG-2 
video, with four audio channels per video stream, in just 3½” of rack space.  The server’s extensive 
feature set makes it an excellent choice for VTR replacement, automation, remote trucks, P-E-G 
applications, corporate and entertainment presentations. The Image Server is produced in both 
NTSC and PAL models.  References in this document to frame counts other than 29.97 or 30 
frames should be understood to be a PAL example.  

The Transition to a Digital Plant 
The Image Server smoothes the transition to digital production and broadcasting by 

providing both composite video (VDCP) and serial digital (SDI) interfaces, plus network transfers in 
MXF format over Gigabit Ethernet. It’s never necessary to add additional video A/D or D/A 
converters, and a full complement of premium-quality MPEG-2 codecs is included as standard 
equipment.  The server’s dual analog and digital personality—for both video and audio—lets it fit 
seamlessly into an existing analog facility, or become part of a new digital build-out. Apart from 
serving its intended purposes, the Image Server is also valuable for its ability to convert between 
different analog and digital media formats in real-time. 

Exceptional Storage Capacity 
The Image Server’s program storage is scaleable to suit the needs of both small and large 

users.  It houses four hard drives within its compact enclosure, providing from 52 to over 170 
hours of storage at 12 Mb/s (Megabits per second).  Storage time is proportional at other data rates.  
The server’s RAID-5 disk array provides a high level of security for stored programs.  By spreading 
parity information across all drives, the RAID array keeps the server in service, even with a failed 
drive.  The multi-drive array also generates the high data rates needed for multiple video streams at 
up to 50 Mb/s, and enables fast program transfers through the Gigabit Ethernet ports. 

Drive Size Storage Capacity 
(4 drives) 

Time @ 12 Mb/s 
2 audio channels 

Time @ 8 Mb/s 
2 audio channels 

120 GB 480 GB 52 hours 72 hours 
250 GB 1.0 TB 112 hours 150 hours 
400 GB 1.6 TB 170 hours 250 hours 

IMAGE SERVER  STORAGE TIMES 
 

The Image Server’s unique ability to play two video streams while recording another, and 
at the same time perform network file transfers over Ethernet, makes it far more than just a 
replacement for a VTR. 
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Image Servers Support Traditional VTR Functions  
The Image Server is a perfect drop-in replacement for popular VTRs.  It saves costs for tape, 

machine maintenance, cassette prep, and storage.  Its three output channels perform any 
combination of tasks, including responding to GUI or automation commands, clip trimming or 
browsing. 

Unlike a VTR, the Image Server can simultaneously record and play a program.  A new 
recording can start at any time, even when two simultaneous playbacks are in progress.  As a VTR 
replacement, the Image Server is controlled through a standard serial interface.  Many popular 
serial protocols are supported, allowing the Image Server to immediately operate with the 
controllers you already own. These include VDCP, Odetics, P2, AMX and Crestron. Six “GPI” 
Input and Output control channels are also provided. 

Compatibility with Automation Controllers  
Image Servers work with automation controllers from many different manufacturers. They 

use established VDCP and Odetics® protocols and provide a 9-pin control input port for each 
server channel, for maximum flexibility.  360 Systems’ Automation Partners provide controllers for 
applications ranging from affordable systems for P-E-G and Pro-AV, up to large-scale broadcast 
solutions. Contact a 360 Systems application engineer for assistance with your requirements. 

Remote Controls 
Hardware accessories are available from third-party manufacturers to perform transport 

control, trimming, clip replay and playlisting (automation).  A table of approved controllers is 
provided elsewhere in this manual. Contact 360 Systems Sales Support team for assistance with a 
specific application. 

The Image Server also provides six GPI inputs for remote play, stop, and record capability 
from push-button panels or other GPI-controlled equipment.  Six outputs are also provided for 
command acknowledgement, and may drive LEDs or logic inputs. 

Extended Feature Set 
The Image Server encodes video in MPEG-2 format, in 4:2:2 Profile with data rates to 50 

Mb/s, or in Main Profile from 2 to 15 Mb/s.  Both I-frame and long-GOP formats are supported.  
MPEG-2 file transfers in MXF-format are compatible with servers from other market leaders. 

The DV and Graphics Option (and the Multi-Format Image Server) allows Direct Digital 
Import™ of DV and TARGA files over Ethernet. DV-25 files may be edited, playlisted, stored and 
played out.  TARGA files will be converted into separate MPEG-2 Key-and-Fill files, which can then 
be played as a synchronized pair for downstream compositing in a switcher.  

As standard equipment, the Image Server includes LTC and VITC time code capabilities, 
closed-captioning, VDCP, P2 and Odetics 9-pin control, GPI inputs and outputs, and Gigabit 
Ethernet ports. Embedded audio is available as an option. 
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Full Slate of Audio Features 
Image Servers include both analog and digital audio circuits, making it an important tool in 

the transition to digital broadcasting.  It includes gold XLR connectors for audio inputs and outputs, 
and each can be configured for either AES/EBU digital or +4 dBu balanced analog.  SDI embedded 
audio is also available as an option.  In discrete digital format, each video program can have four 
channels of audio, whereas analog I/O provides two channels.  (An AES/EBU line on a single XLR 
connector carries two audio channels, so a given number of XLR connectors make more channels 
possible in digital format.) 

360 Systems brings over 30 years experience  in broadcast and pro-audio to the audio 
design of Image Servers.  It utilizes a 24-bit word, and delivers a 20 dB improvement in SNR (10 
times!) compared with older 16-bit audio systems. An insertable sample -rate converter is included, 
plus input circuits with excellent hum and RF rejection, and 20 dB of headroom.  360 Systems’ Bit-
for-Bit® design strategy guarantees that when a Dolby®-E, Dolby AC3, or any other encoded 
program is recorded, it will play back correctly.  

On-Screen Graphic User Interface 
The Image Server’s On-Screen graphic user interface (GUI) gives fast access to all server 

functions. It is controlled by a standard keyboard and mouse (supplied) and requires only a VESA-
compliant SVGA display.  

The GUI displays a complete control panel for each server channel, which includes 
transport control buttons, clip file management and head and tail trimming, allowing the Image 
Server to operate as three self-contained VTR equivalents. 

System configuration is clear and straightforward with the On-Screen GUI.  It provides 
access to MPEG-2 encoding parameters, audio channel and time-code settings.  Whenever new 
server features are installed (using the built-in CD-ROM drive) new set-up parameters and user-
interface features become immediately available. 

The GUI can be remotely accessed by a Windows PC through an Ethernet link, or of a 
wide-area connection using a high-security remote KVM product. Contact 360 Systems sales for 
complete information on these options.  

MXF Networking over Gigabit Ethernet 
Image Servers move beyond providing just a simple base-band solution for video input and 

output. MXF file transfers over Gigabit Ethernet open the door to new IP solutions for transferring 
video across the room—or across the country—at exceptionally low cost. 

By using economical switches  and computer-industry infrastructure, the Image Server’s 
Gigabit Ethernet design enables low-cost networking of broadcast operations from ingest to storage, 
for editing, play-to-air, and archiving.  The Image Server moves programs many times faster than 
real time, saving time and streamlining operations. 

360 Systems’ MXF implementation uses Operational Patterns 1a and 1b.  It has been tested 
for compatibility with MXF files from many other manufacturers.  360 Systems can make Image 
Server  MXF files available for testing and evaluation through our FTP Site.  Contact the customer 
service department to arrange for access.  
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Reliability Counts 
360 Systems has 34 years experience manufacturing equipment for television broadcast and other 
critical industries.  We understand quality and reliability, and we’ve paid close attention to design 
issues like power, cooling, and protecting stored data.  We’ve even included alarms on key server 
components.   

Self-Mirroring Image Servers 
When the very highest level of reliability is required, Image Servers are priced so attractively that it 
can even make good business sense to install them in redundant pairs. 360 Systems offers a Dual 
Server Controller that allows an automation system to transparently control a redundant pair of 
Image Servers in parallel.  For more information on redundant servers, visit our web site at 
www.360systems.com or contact 360 Systems’ Sales Department. 
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Key Features and Benefits 
The Image Server is designed from the ground up to deliver outstanding performance and value in 
a multi-channel MPEG-2 and DV-format server.  Three video outputs with analog, digital, and 
Gigabit Ethernet interfaces make it an excellent choice for the next-generation plant. 

 

• MPEG-2: Main Profile @ Main Level and 4:2:2 Profile @ Main Level to 50 Mb/s. 

• Optional import and playout of DV-format video and TARGA graphics files 

• Drag-and-Drop FTP transfers from popular desktop editing programs 

• Internal RAID-5 storage configurable to 170 hours 

• Three simultaneous video outputs, 1 video input  

• SDI and composite video inputs and outputs 

• Includes balanced analog and AES/EBU digital audio ports as standard equipment 

• Four audio channels (2 AES stereo pairs) for each video channel 

• Embedded audio available as an option 

• Serial control via VDCP, P2, or Odetics, AMX or Crestron protocol 

• Compatible with leading broadcast automation systems 

• Fast FTP network transfers on Gigabit Ethernet  

• LTC Time code input and output; VITC written and read 

• Frame-accurate head and tail trimming 

• Advanced Playlisting : Build, edit, store, playback, and loop multiple lists 

• Looping 

• Closed-Captions 

• Keyboard shortcuts speed editing tasks 

• Set-up, administration and control via graphic user interface 

• Remote GUI software for Windows available  

• 32-character file names 

• Compact 2RU (3½”) [88mm] enclosure, low power consumption 

• Low cost 
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Applications for 360 Systems’ Image Servers 
Image Servers add value to a wide variety of applications in broadcasting, cable distribution, video 
production, P-E-G, entertainment and sports venues.  Many of these tasks are impractical with 
videotape because of its nature as a slow-response, single -channel device.  In contrast, the video 
server provides immediate record and playback of any source, and lends a spontaneous 
appearance to broadcasts, presentations and live events. 

 

• News Production – Promos, teasers, intros, news segments, graphics, animation 

• Graphics Server – Play TARGA files with key-and-fill 

• Master Control – Program and commercial playout, station IDs, promos, teasers 

• Program Ingest – Automated capture of satellite, tape, microwave, and fiber feeds 

• FTP File Delivery – Deliver news, promos, spots over DSL or ATM lines 

• Play-to-Air Server – Playback under automation control 

• Program Store-and-Forward – Temporary storage for subsequent delivery  

• Commercial Insertion – Playout under automation control 

• Instant Replay – Hot Key playback of sports plays, news clips, stills, and graphics 

• Sports Shows and Events – Player bios, animations, graphics, promos 

• Game Shows – Prizes, graphics, animations, promos 

• Talk and Variety Shows – Promos, teasers, intros, outros, graphics, animations 

• Award Shows – Nominees, categories, promos, graphics, animations 

• Theme Parks and Casinos – Playout for show backgrounds, event lists, kiosks 

• Houses of Worship --  Projection displays, program production, broadcasting 

• Colleges and Universities – On-campus networks, production, presentations 

• Digital Signage – drive projectors, flat-panel displays, kiosks 

• Entertainment Industry – Road show displays, projection 

• Public Access, City Governments – Long recording times, high quality video 

• Small & Mid Broadcast Markets – High performance at an attractive price 
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Available Models and Options 
 
Image Server 2000  Model V2000-120 

Provides 1-input, 3 outputs, MPEG-2 encoding to 50 Mb/sec, MXF network  
transfers, head and tail trimming, playlisting, (4) 120 GB drives in RAID-5 array 
provides 52 hours of storage at 12 Mb/sec. 

Image Server 2000  Model V2000-250 
As above, with 112 hours of storage at 12 Mb/sec 

Image Server 2000  Model V2000-400 
As above, with 170 hours of storage at 12 Mb/sec 

DV and Graphics Option   
Upgrades Image Server 2000 to include direct import of DV-format video and  
TARGA graphics files over Ethernet.  Plays DV in native format and graphics with  
simultaneous key and fill.  Direct FTP file import from Photoshop®, After Effects®,  
Final Cut Pro®, Xpress DV/Pro™, Liquid Edition, Vegas video.  May be added to  
an existing Image Server. 

Multi-Format Image Server  Model V2000-MF-120   
This Image Server includes direct import of DV-format video and TARGA graphics  
files over Ethernet.  Plays DV in native format and graphics with simultaneous key  
and fill.  Direct FTP file import from Photoshop®, After Effects®, Final Cut Pro®,  
Xpress DV/Pro™, Liquid Edition, Vegas video.   

Multi-Format Image Server  Model V2000-MF-250   
As above, with 112 hours of storage at 12 Mb/sec 

Multi-Format Image Server  Model V2000-MF-400   
As above, with 170 hours of storage at 12 Mb/sec 

Embedded Audio Option   
Upgrades Image Server 2000 or Multi-Format Image Server for operation with  
SDI embedded audio. Provides 4-channels, 48k sample rate, 20-bit resolution on  
input and all outputs. May be added in the field to servers with S/N after 300. 

Advanced Playlisting Upgrade 
Upgrades earlier Image Servers to provide Advanced Playlisting capability (standard in servers from May 
2005). 

Storage Upgrades 
Upgrades any Image Server having small drives to provide either 112 or 400 hours of storage (at 12 
Mb/sec).  Field installable. 

PAL Models 
Add the suffix PAL to model number when ordering. Specify type of mains cord required. 
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Maintenance Spares  
360 Systems’ is committed to keeping your Image Server on air.  The server contains hard disk 
drives and other fragile electronic devices; and while it is designed to be very reliable, having spare 
parts on hand in the event of a fault is a good practice.  Hard disk spares are particularly important. 
Please consider these important options at the time of your purchase, or shortly after. 

• 120 GB Image Server Hard Drive for 52-hour servers 
• 250 GB Image Server Hard Drive for 112 hour servers 
• 400 GB Image Server Hard Drive for 170 hour servers 
• Image Server Power Supply, universal line voltage     
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Installation 

Unpacking 
Your Image Server has been carefully inspected and calibrated before shipment to allow immediate 
operation upon installation.  Check all items for signs of visible damage which may have occurred 
during shipment.  If any item is damaged, contact the carrier to file a claim. 

Keep the packing materials in the event that a unit must be shipped by you.  If the original 
packaging is not available, make sure that the following criteria are met: 

• Packaging must be able to withstand the product weight. 
• Product must be held firmly within the package. 
• There must be at least two inches (50mm) of space between the product and outer container. 
• The corners of the product must be protected. 

 

Package Contents 
Confirm that all items on the packing list have been received.  Contact 360 Systems if any item 
is missing. 

ü Image Server 
ü Keyboard 
ü 2-Button Scroll Mouse. 
ü Software CD-ROM, backup copy 
ü Rack Mount Hardware Kit 
ü Operations Manual 
ü Quick Start Guide 
ü Audio Connector Labels 
ü Power cord 
ü Warranty Card 

 
The Image Server is not shipped with a video monitor.  You may select a VESA-compliant CRT 
or LCD monitor suitable for your application. 

If you own more than one Image Server, it may be appropriate to use a single keyboard, 
monitor, and mouse with a KVM switch to select between servers. 
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Rack Mounting 
Refer to instructions packaged with the Rack Mount Hardware Kit for specific installation 
information. 

Note: If you plan to use digital audio, be sure to change the configuration of the Analog/Digital 
Audio Jumpers inside the unit before mounting the Image Server in a rack.  The jumpers are factory 
set to the Analog audio position.  For more information about changing the jumpers, see 
Analog/Digital Audio Selection on page 106. 

There are four adhesive-backed rubber feet on the Image Server, which may be removed when 
rack mounting the unit. 

Generally, the Image Server will be mounted in a 19” rack enclosure having 10-32 tapped holes.  
The Image Server can be adapted to rack enclosures having untapped round or square holes by 
using the nuts and washers included with the mounting kit. 

Cables attached to the rear of the Image Server should be supported by the rack mounting rails.  
Do not support substantial cable weight from the Image Server. 

Keep the air vent slots on the sides of the Image Server free of obstructions. 

Remove the front panel to expose the rack screw slots.  Fasten the Image Server into the rack using 
10-32 flat-head Phillips screws (provided).  Replace the front panel.  Tighten the front panel access 
screws. 

Important Information on Equipment Cooling 
When many pieces of equipment are mounted in an equipment rack, a considerable amount of 
heat may be produced, which must be removed efficiently.  Further, a lower operating temperature 
will make equipment operate  more reliably, and it will last longer.  In the extreme case, excessive 
temperatures cause rapid equipment failure, and damage which can be difficult to repair.    

Heat in an equipment rack should be removed by forced air.  This is often accomplished by 
blowers installed in the top of the rack, venting into the room.  An alternative is to draw hot air 
from the top of the rack into an air-conditioning return duct, and not vent it into the equipment 
room; cold air should be ducted into the bottom of the rack. 

The optimum air temperature for cooling electronic equipment is 25° C (72° F).  When many 
pieces of equipment are contributing to the heat load, a substantial air-flow will be needed, and the 
inlet temperature may need to be lower. 

Check These Points 

• Are all ventilation holes in the Image Server free of obstruction? 

• Can blowers or HVAC system adequately remove heat from the equipment rack? 

• Have you measured the actual temperature inside the rack? Do this near the top. 

• Verify that the HVAC system is not on a timer that can shut off on weekends or holidays. 

• What procedures are in place to protect the equipment when the HVAC system fails? 
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Important Information on Power Conditioning 
It is good practice to operate an on-air video server from an Uninterruptible Power Source, or UPS.  
All utility power systems experience occasional transient events, including brownouts and 
dropouts, which are capable of taking a server off the air.  It is the station operator’s job to plan for 
and overcome such contingencies. 

UPS units suitable for smoothing short-term power line problems come in two varieties:   

Change-over UPS Design  
This design senses drop-outs and low-line voltage, and switches its output to an internal inverter 
operating from a battery.  This UPS is low in cost, and is most often used in non-critical 
applications such as desk-top computers.  A disadvantage is that it may create its own power 
transients when switching  between utility power and its inverter supply. 

Continuous Conversion UPS Design 

This improved design continuously converts utility power to DC, stores it in a battery, then 
produces isolated AC power from an inverter.  It never switches, and is immune to input transients, 
brownouts, and blackouts.  Models are available with batteries of almost any size, making the 
continuous-conversion UPS suitable for transient suppression or long-term operating power the 
absence of utility power. 

Recommended UPS Models 
 The following makes of continuous conversion UPS systems are suitable for use with 360 Systems’ 
Image Server products: 

• Eaton/Powerware Corporation, Model 9125, www.powerware.com 

About Image Server Software 
The Image Server is shipped with its operating system and application programs already installed. 

The first time that it is started, it must be connected to a keyboard, monitor and mouse.  The Image 
Server will ask you to accept the licensing agreement before it will allow any operation.  This 
screen will only appear during the initial startup, or until accepted. 

THE CD-ROM SUPPLIED IS ONLY FOR USE IN REINSTALLING THESE PROGRAMS.  DO NOT 
LEAVE IT IN THE CD-ROM DRIVE. 

If for any reason it becomes necessary to reinstall any software, refer to the Maintenance  chapter 
for instructions. 

The CD-ROM drive is intended only for installing software.  It may not be used to load video or 
audio program content.
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The Image Server Hardware Interface 

Front Panel Features 
 
 

 
Figure 1:  Image Server Front Panel 

 

Power ON/OFF button 
The blue front panel button initiates start-up and shut-down of the Image Server.  Press it 
momentarily to start the server.  A sequence of start-up screens will appear, ending with the 3-
channel graphic user interface. 

When the Image Server is running, pressing the blue button momentarily will cause the system 
to begin an orderly shutdown.  In the event that the system has stopped responding to 
commands and will not shutdown, hold the button in for 4 seconds to force a power down. 

Do not use the rear panel switch on the power supply to shut down the Image Server.  Abrupt 
power loss can cause loss of information stored on the disk array.  See Shutting Down Image 
Server  on page 27 for details. 

Indicators 
Five blue LED Status Indicators appear on the front panel.  These indicators are illuminated 
continuously when the system is functioning normally.  See the table Front Panel Indicators on 
page 102 for diagnostic meanings. 
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Rear Panel Features 

Video Inputs 
The Image Server provides a single video input channel.  This channel includes separate BNC 
inputs for serial digital (“SDI” per SMPTE 259M) and analog video (CVBS) signals.  The graphic 
user interface allows selection between the two.  Encoding to MPEG-2 format is performed 
within the server.  Video inputs have a fixed 75-ohm termination. 

Video Outputs 
Video outputs are provided in SDI and Composite (CVBS) formats simultaneously.  Digital 
video appears in SDI format at 270 Mb/s and conforms to SMPTE 259M.  Analog video is in 
conventional composite (CVBS) format. 

Video Output 1 can superimpose time code over picture as a “window burn” on NTSC models. 
This feature is available only on the CVBS video output, and is enabled through the On-Screen 
graphic user interface. 

Audio I/O 
The Image Server can provide audio inputs and outputs in three formats: 

• Balanced analog audio at the industry-standard reference level of +4 dBu. 

• Digital audio in AES/EBU format per AES-3-2000. 

• SDI embedded audio, 4-channels (server option) 

These multiple standards facilitate the transition from an analog studio to digital production and 
broadcasting, and ensures that the server can operate with virtually any external equipment.  
Note that both analog and AES/EBU audio signals are not available at the same time on a given 
input or output.  Internal jumpers select between analog or digital; however, input and output 
can be set up differently, if desired.  A set of XLR-3 connectors allows high-quality connections 
to be made in either format. Embedded audio, when installed as a server option, appears in the 
SDI output at all times. 

Analog Audio Capability 
When the analog audio input format is selected, each video channel has two audio 
channels, recorded together as a stereo pair.  Trimmers allow adjustment to unity gain. 

Digital Audio Capability 
When AES/EBU digital audio is selected, each video channel has four audio channels, which 
are recorded as two stereo pairs.  Because a single XLR connector carries a stereo pair in 
digital format, and only one (mono) channel in analog, the server provides an extra pair of 
audio channels when used with digital audio signals. 
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Embedded Audio Capability 
When SDI embedded audio is selected, four audio channels are available for recording. 
Embedded audio is always present in the video outputs. Note that discrete audio (analog or 
AES/EBU) is also available on XLR connectors, at the same time embedded audio appears in 
the video stream.  Embedded audio has a 20-bit resolution. 

Audio Word Size and Sample Rate  
The Image Server employs 24-bit audio A/D and D/A converters, and records audio into a 
24-bit frame, regardless of the word size received.  The sample rate is fixed at 48K. 

Analog/Digital Audio Selection 
The following drawing illustrates jumper positions to select between analog or digital audio.  
Note that each output may be individually selected.  As described earlier, when analog audio is 
selected, only two channels are available, while selection of AES/EBU digital audio provides 
two stereo pairs, one on each XLR connector.  Both jumpers for each channel (Left & Right, or 
Main & Aux) must be set together, either analog or digital.  The Image Server must be power 
cycled for jumper changes to take effect.  For more detail, see Analog/Digital Audio Selection 
in the Maintenance  chapter. 

DIGITAL
ANALOG

JUMPER BLOCK PAIR SHOWN
IN ANALOG POSITION

JUMPER BLOCK PAIR SHOWN
IN DIGITAL POSITION

GAIN ADJUST

 
Figure 3: Jumper location on audio card for selection of analog or digital audio. 

 

Audio Format Labels 
A sheet of labels is supplied with each server for identifying the audio connector 
configuration on the rear panel.  After the jumpers are set, apply appropriate “Analog” or 
“Digital” labels above the corresponding connectors on the rear edge of the top cover. 

Serial Control Ports 
Each of the Image Server’s three 9-pin “D” connectors permits independent control of any of 
the three video channels.  They can accept serial commands in VDCP, P2, Odetics, AMX or 
Crestron protocol.  Its multiple serial ports allow you to simultaneously connect an 
automation controller and a desktop controller.  See the chapter on Automation Control for 
more detail on this subject. 
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Most broadcast automation systems, and some remote control panels employ the VDCP 
protocol.  A detailed list of supported VDCP commands will be found in Appendix B. 

Many controllers used for transport, instant replay, and edit control employ P2 or Odetics 
protocol.  The Image Server P2 protocol emulates BVW-series tape machines. Many Pro-AV 
systems employ AMX and Crestron protocol. 

Gigabit Ethernet Ports 
Two Gigabit Ethernet ports are provided on the Image Server.  The NET 1 port is intended for 
network transfer of program content between video servers.  The server supports MXF file 
transfer (MPEG-2, Op 1a and 1b), which allows content interchange between products from 
different manufacturers, as well as file import in various formats from desktop editors. The  
NET 2 port is reserved for data transfer between two Image Servers, when configured for 
redundant operation.   

GPI Control 
The Image Server provides six GPI inputs for control of machine functions, which appear on 
the 25-pin GPI connector.  This “General Purpose Interface” can be connected to switch 
contacts or an open-collector transistor output.  GPI inputs are programmable, and can provide 
machine control such as PLAY, STOP, or RECORD through simple external switches. 

The Image Server also provides six GPI status outputs which may be used to confirm that a 
command has been received, or for other purposes.  These functions of these open-collector 
outputs are programmable, and may be used to operate an LED, or they can be connected to a 
suitable logic input.  The pin-out for the GPI connector will be found in Connector 
Specifications. 

Genlock Sync Reference 
A BNC connector is provided on the rear panel to receive a genlock signal.  During normal 
operation, the Image Server should be referenced to an external genlock reference in the form 
of CVBS Black.  As with all video systems, this server and equipment connected to it must be 
referenced to a common genlock source.  The GENLOCK input provides a fixed 75-ohm 
termination. 

An internal crystal reference is also provided so that the server can be used as a stand-alone 
player, and also for convenience in performing tests in the laboratory.  Use particular care 
when operating the server with an internal reference, as synchronization with other equipment 
is not possible.  Additionally, recording is not allowed when using the internal crystal. 

Genlock Signal Quality 
A genlock signal connected to the Image Server must conform to the RS-170A standard.  PLL 
circuits used within the server remove residual jitter from the genlock signal.  This may 
preclude the use of low-cost VTRs that introduce time instability (wow) into their output, 
making them inaccurate as a genlock input source. 
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LTC Time Code Input 
A LTC time code input is provided on the LTC IN BNC connector.  This input may be selected 
by means of the On-Screen user interface and recorded as a time code reference.  The LTC 
input provides a >10k ohm termination. 

LTC Time Code Output 
An LTC time code output is provided on the LTC OUT BNC connector.  It may be selected by 
means of the On-Screen user interface to output time code from any of the three video 
channels during playback.  The LTC output has a low source impedance of <5 ohms. 

Keyboard 
Attach the alphanumeric keyboard to the purple 5-pin KEYBD connector to control the server 
and manage clips with the On-Screen graphic user interface.  Note that the server will only 
recognize the keyboard if it is attached before power up.  

Mouse 
A two-button scroll mouse is provided with the Image Server.  Plug the mouse into the green 
5-pin MOUSE port.  Note that the server will only recognize the mouse if it is attached before 
power up. 

Monitor 
A VESA-compliant computer monitor may be connected to the 15-pin VGA video port.  The 
Image Server resolution is fixed at 1024 x 768 pixels, with a refresh rate of 72 Hz.  This is 
best-viewed on 17-inch or larger monitors.  360 Systems does not provide monitors for the 
server.  Note: Do not use older monitors that do not state they are VESA compliant. 

 

Serial Port 
The system board serial port is not used.  Make no connection. 

 

USB Ports 
The system board USB ports are not used.  Make no connection. 

Power 
An IEC mains socket is provided on the rear panel for power input.  The Image Server  will 
accept worldwide power sources in the range of 100-240 volts AC, 50-60 Hz.  The server is 
shipped with a power cord appropriate for the region in which it is sold.  Replace the power 
cord only with one of the same type and rating. 
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DO NOT use the power supply switch to shutdown the Image Server.  Shutdown the 
system only by momentarily pressing the front panel power button, or through the 
SHUTDOWN command on the On-Screen user interface.  The rear panel power switch 
should only be used if the Image Server fails to shutdown after holding the front panel power 
switch for 4 seconds. 

The server may also be shut down from the graphic user interface.  Click 
START>SHUTDOWN>SHUTDOWN.  After a few seconds, shutdown will occur. 
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Basic Operations 
This section introduces the Image Server Graphic user Interface (GUI), its menus and its 

operating controls.  If you want to skip ahead to learn how to record a clip, go to page 40.  Skip to 
page 42 to read about playing a clip. 

360 Systems has designed the graphic user interface as a convenient way to manage Image 
Server operations.  With it, you can control basic operations such as recording and playout.  You 
may also set up video and audio formats, assign remote control channels to video ports, and set up 
many other aspects of the machine.   

All GUI software is pre-installed on the Image Server.  It is also provided on the Image 
Server software installation CD-ROM.  The GUI is operated with a keyboard, mouse, and monitor 
connected to the Image Server rear panel.  Attach these devices only when power is turned OFF. 

The Image Server Desktop 
The Image Server desktop is similar to many computer system graphic interfaces.  There is a task 
bar and start menu at the bottom of the screen.  The Image Server desktop is always running while 
the machine is on.  Use the Start menu button to launch applications, manage the system, or to 
shutdown the server. 

Launching the Graphic User Interface 
The GUI appears automatically during boot up.  If On-Screen has been closed, click Start, then 
Image Server GUI to re-launch the GUI.  It will then appear and fill the screen.  The window 
can then be moved, minimized, or closed as desired. 

Shutting Down Image Server 
Click Start, then Shutdown, then either Shutdown to begin an orderly shutdown, or Full 
Restart to do an orderly shutdown and Restart. 

Alternatively, momentarily pressing the front panel power button will cause the system to begin 
an orderly shutdown.  Image Server will acknowledge the button press with an audible beep 
and the front panel lights will begin to flash together.  Any operation in progress will be halted, 
and any unsaved work will be lost. 

In the event that the system has stopped responding to commands and will not reset by 
pressing the front panel button (no beep is heard), press and hold the button for about 4 
seconds to force a power down.  Wait 5 seconds, and then the system may be restarted with 
another press of this button. 

DO NOT use the rear panel power supply switch to shutdown the Image Server.  Doing so 
may cause loss of unsaved data, and may require the RAID array to re-synchronize – a process 
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that could take several hours.  Shutdown the system only by momentarily pressing the front 
panel power button, or through the GUI. 

Keyboard Shortcuts 
Most operations the graphic user interface can be performed using keyboard shortcuts.  See the 
list of keyboard shortcuts in Appendix C. 

On-Screen Main Menu Bar 
The main menu bar contains the following headings and sub-menus.  Each menu choice is 
explained in detail in a later section. 
 

File Transport Configure Window Help 

Exit Channel 1 > System…  Cascade About 
 Channel 2 > Options… Tile  

 Channel 3 > Date/Time…  Close All  

  Channel 1…    Clip List  

  Channel 2…   

  Channel 3…   
 

 

Figure 4:  Graphic User Interface with Clip Transport Windows 
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File 
The File menu provides access to the Exit command. 

Exit 
Exits the GUI. 

Transport 
Select a video channel from the dropdown menu, then select Clip… or Playlist… to bring up 
the GUI control panel for that channel. 

Clip 
Open this window to play, edit, and perform file operations on individual clips.  A full set of 
transport controls are available in this mode. 

Playlist 
Build, edit, manage and play playlists.  These operations are described in detail in the 
Playlist chapter. 

Configuring the Image Server  
All user-configurable aspects of the Image Server are grouped below this menu. 

System  
Open this dialog window to configure general control and sync parameters, such as GPI, 
sync, time code, and video standard.  See System Configuration on page 75 for more 
information. 

Date/Time  
Open this dialog window to set the Image Server’s internal system date and time.  This 
information will be used to time stamp the data files of new recordings. 

Channels  
Select a video channel from this dropdown menu to configure channel-specific audio, video, 
and time code parameters.  For more information about changing channel setups, see 
Channel Configuration on page 82. 

Window Arrangement 
Choices in this menu change the way the GUI windows are displayed.  Use the CTRL+TAB key 
combination to change the active GUI window in rotation, or use the mouse to activate 
another window. 
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Cascade 
Arranges all open windows so that they are overlapping, but offset.  This choice is especially 
useful with small monitors or low-resolution monitors. 

Tile 
Arranges all open windows so that each is fully visible at the same time.  This choice is 
especially useful with larger monitors. 

Close All 
Closes all open windows.  Note: Transport windows must be in the idle state to close. 

Clip List 
Opens a window containing all available clips on the Image Server.   When in Playlist mode, 
with the Edit Box checked, files may be dragged and dropped from Clip List window into the 
Playlist window. 

About 
Displays the Image Server software version. 
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Clip Transport Window 
The graphic user interface is used to control transport operations such as play, stop, record, 

and basic head and tail trimming.  These functions are found in the Clip Transport window for 
each channel.  Channel 1 is both a Record and Play channel, while channels 2 and 3 are playout 
only.  Each transport window has its own file menu, which is used to locate and play existing clips, 
or to create new clips.  (Refer to Figure 5, below.)  The graphical layout is similar for each channel, 
except that only Channel 1 also contains Record and E-E buttons. 

From the main menu bar, select Transport, then select the channel number to be 
controlled.  From the dropdown menu, select Clip or Playlist.  Up to three Channel Transport 
Windows may be opened at once, one per server channel.  The Window menu may be used to 
arrange the channel windows on the screen.  Windows may also be arranged manually by using 
the mouse and standard window sizing controls. 

The server will establish a connection to control the channel when its channel window is 
opened.  A message, “Connected to host” should appear in the bottom status bar of the main 
window.  If the Image Server program has not started because the system is busy, the message 
“Connection to Host Refused” will appear.  This is usually a temporary condition that will resolve 
itself without intervention. 

Each Clip Transport window includes a main menu bar, status bar, current clip name, a 
large current time code display, and the standard transport controls PLAY, STOP, FAST 
FORWARD, REWIND, LOOP, EJECT and a shuttle slider.  Channel 1 also provides REC and E-E.   

A number of direct-action buttons are also provided: Go To Head Point (|<- ), Go To Tail 
Point (->| ), JOG+ and JOG-.  An edit region provides Mark In and Mark Out entry buttons, and 
time code displays reflecting these positions.  Review Clip (|<-->|) and Review Out (->|) buttons 
provide a means to audition an entire edited clip, or just its ending.   

 
Figure 5: Channel Transport Window 

Menus 
The following headings describe each clip window File  menu: 
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File 
The File menu provides six file-management choices.  Columns can be sorted in ascending or 
descending order by clicking the column header bar to toggle the setting. 

New 
The recording process begins with naming the new clip.  The New menu choice opens 
a dialog box in which a new clip may be named (Figure 4).  Clip names can include 
any alphanumeric ASCII character, up to 32 characters. 

Note: File naming is case sensitive.  Upper case letters sort before lower case.  The 
name FILE sorts in the order shown, based on differing capitalization:  FILE, File, fiLe, 
and file. 

The file dialog box includes an advisory message labeled PERCENT DISK FULL.  When this 
figure becomes high, it is wise to consider deleting unnecessary files from the drive. 

 
Figure 6: File Dialog Box 

 
After entering a clip name, choose Create to create a new clip file.  The Image Server 
will place itself in Record-Ready mode.  If the server was previously in the Play -Ready 
mode, a brief pause will occur.  The channel status message will report “Ready” and 
the REC button will become functional.   

Refer to the following main section titled Recording for more information on setting up 
and making recordings. 

Open 
In the Play-Ready mode, the Open command presents a window from which a clip 
may be selected (Figure 7).  A new selection closes the previously open clip, and the 
newly selected clip becomes ready for playout or trimming. 

Refer to the following main section titled Playing a Clip for more information on that 
subject. 
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Column headings in the file dialog box are: Title, Duration, Profile, Mb/s, GOP, and 
Tracks.  Click on the column heading to sort the list by that column.  Click on the 
selected heading again to reverse the sort order.  

Most headings are self-explanatory.  GOP is Group of Pictures length in frames.  If the 
GOP listing is 1, then the clip has only one frame per GOP (I-frame only).  The Tracks 
column lists the type of tracks associated with each clip.  Clips may have any of the 
following track attributes, depending on how they were recorded. 

Track Attribute Recorded Track 

V Video 
A 1/2 Audio Tracks 1 & 2 
A 3/4 Audio Tracks 3 & 4 
CC Closed Caption 

 

 
Figure 7: Selecting a Clip to Open 

Save 
The Save command saves a clip, including any new head trim or tail trim settings 
associated with it.  Any operation, such as Exit, that would cause new edits to be 
discarded will prompt the user to confirm a save of those trims. 
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Save As 
A region defined by Mark-In and Mark-Out may be saved as a new clip with a unique 
name.  Use the Save As button for this purpose.  A dialog box will appear with a 
prompt to enter a clip name.  After entering the name, click Save As again to save the 
clip with a new name.  When using Save As it is a good practice to give new sub-clips 
a name related to the original. 

A clip consists of audio/video data and related attributes.  The attributes include the 
current starting and ending points – the In and Out edit points. 

When a copy of a clip is made using the Save As feature, only the In and Out edit 
points are actually copied to the new clip.  The base audio/video data is shared among 
all copies.  In this way, each copy may have different In/Out Points without using 
additional disk space to duplicate the audio/video data.  Additionally, the In and Out 
Points can be adjusted later to any position within the original recorded material. 

Clips created with the Save As feature are noted in the File List as having a duration 
equal to their play time, as defined by the In and Out-Marks.  The sum of these 
durations may far exceed the anticipated recording time available on the disk array.  
However, these “v irtual files” take no disk space.  Refer to the Percent Disk Full and 
Time Remaining estimation in the File > New… dialog box, or at the bottom right of 
the main application window. The Record Time Remaining estimate is based primarily 
on the current record configuration bit rate, the number of audio tracks selected, and 
the available disk space. 

Another important concept is that there is no parent-child relationship among clips.  
The original clip name may be deleted without affecting any clip created by using Save 
As.  Renaming clips will never cause the Image Server to lose track of its relationship to 
the original recorded data.  The original recording will remain on the disk as long as 
there is at least one clip file pointing to it. The original recording will be automatically 
deleted when the last clip associated with it is deleted.  Deleting all related clips is the 
only way to free disk space.  

Rename 
Rename  is a drop-down selection under File, allowing a new or more useful name to 
be applied to an existing clip (Figure 8).  Select Rename , and then within the window, 
select the file to be renamed.  Type a new name in the Rename  window, then click the 
Rename  button.  The old file name will be replaced with the new one. 
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Figure 8: Renaming a Clip 

Delete 
One or more files may be deleted at once with the Delete command.  There are four 
ways to tag files for deletion: 

Using the left mouse button highlight a file in the Files window, then press the Delete 
key. 

Select a file to be deleted using the left mouse button.  While holding the mouse button 
down, drag the mouse through other sequential files, highlighting all for deletion.  
Then press Delete. 

Select the first file in a sequential list of files to be deleted.  Press and hold the Shift key, 
then click on the last file in the list to be deleted.  The selected list will appear 
highlighted and all may be deleted with a single stroke of the Delete key. 

While holding the Control (Ctrl) key down, click to select any number of files (in any 
order) to be tagged for deletion, then press Delete. 
Note: The Ctrl key is a toggle selector, and may be used to de-select files that were 
accidentally highlighted.  This is also useful in combination with the Shift key.  A 
large block may be highlighted using the Shift key, then use the Ctrl key and mouse 
to de-select individual files from within the highlighted list.  The Ctrl key may also 
be used to add additional files to the block created with the Shift selection method. 

Exit 
Exit will close the current Channel window.  On exiting, the user will be prompted to 
save a recording if the file or its edits are new.  Exit is grayed-out when Record or Edit 
operations are currently in progress. 

The Status Bar 
A status bar appears at the bottom of the window that provides system information to the user 
including GENLOCK, INPUT VIDEO DETECTED, and TIME REMAINING—PERCENT FULL.  Messages such 
as CONNECTED TO HOST or CONNECTION TO HOST REFUSED are also displayed to help diagnose 
problems. 
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Transport Controls 
The clip window button functions are common to both recording and playing a clip.  This 
section introduces the buttons by function.  See Recording on page 40, and Playing a Clip on 
page 42 for relevant procedures. 

Serial Control 
Select the Serial Control check box to control the channel through the serial control ports 
(VDCP, P2, or Odetics protocol).  The GUI can take control of a channel at any time by de-
selecting the Serial Control check box.  Return control to the remote controller by re-
checking Serial Control.  If a remote controller is operating on the channel, de-selecting 
Serial Control will allow the GUI to assume control of the channel and remote commands 
will be ignored.  Closing the channel window saves the Serial Control setting in the last-
selected state. 

NOTE 1: When the Channel is under Serial Control, the Transport window will continue 
to display current activity. 

NOTE 2: Some remote controllers may need to be reinitialized to restore proper operation 
after Serial Control released then reselected. 

Current Time Code Display 
A large Time Code display indicates the current position in the active clip, measured from 
the Mark In point.  When a clip is loaded to play, it will be cued at the Mark In point, which 
may also be the SOM if no Mark In point has been set. 

If Edit mode is entered, the clip will cue to the SOM.  The time code display then shows the 
current position, measured from the  SOM. 

Current Clip Name 
This window, below the main Time Code Display, shows the name of the currently loaded 
clip. 

Channel Status Display 
Located next to the clip name window, the Status Display reports the current state of the 
transport: Stopped, Playing, Ready, Recording, Variplay, Busy, Cueing, Still, and Idle. 

Record Button 
The Record function is available only on Channel 1.  It is disabled in Play mode.  The 
Record button becomes active after a new clip has been named under the File>New dialog.  
Click on REC to initiate a recording.  The button is illuminated red when recording. 

A brief pause will occur when Channel 1 is switched between Play-Ready and Record-Ready 
modes.  The status display will report “Ready” when the new mode is available.   

NOTE 1:  An external genlock signal must be connected to the server to make recordings. 

NOTE 2:  The maximum recording time is about 12 hours.  The Image Server will stop 
recording and save the file at that time. 
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Play Button 
The Play function becomes available after a clip has been loaded for playback.  The Play 
button initiates playback at 1x speed. 

Looping 
A LOOP button appears in each channel transport window.  This alternate-action button 
causes a clip to repeat continuously.  Loop is a feature that can be turned ON or OFF at any 
time.  It can be left ON during off-speed play or editing without any effect.  Loop only works 
when the button is ON and the clip plays at 1x for at least 10 frames before the Out Point.  
Playing a loop must be initiated with the PLAY button. 

Disengaging LOOP while a clip is playing will let it play to its end point, then stop.  Use the 
STOP button to stop the clip immediately. 

Loop can be very useful when doing voice -overs, dialog dubbing, creating bugs, or logo 
animations.  Loops of scenes with similar-looking beginnings and endings can be edited to 
appear nearly seamless. 

Eject Button 
Eject unloads a clip.  Playback, recording, or any other transport operation is terminated.  
Video will go to black.  The clip is cleared from the channel.  It is not necessary to eject a 
clip before loading another. 

Stop Button (Still)  
Stop pauses the current clip during Play, Fast-Forward, or Rewind.  Video appears as a still 
frame.  Click Play, FF, Rew, Jog, GoTo, or Shuttle to continue from the current position. 

E-E Mode 
This button appears only in the Channel 1 Record/Play window. Prior to recording, it is 
useful to monitor a signal to be recorded, but from the server’s output.  The term “E-E” (E-to-
E) refers to an electrical path through the server, from input to output connector, without 
going to disk.  E -E Mode toggles automatically as described below, but can also be switched 
manually at any time. 

When a new clip is created for recording, the E -E input monitor is automatically switched 
ON.  When a clip is opened for play on Channel 1, E-E monitoring is automatically switched 
OFF.   

When Channel 1 is switched to playlist mode, the E -E monitor is automatically switched 
OFF.  E -E mode cannot be toggled while the channel is in playlist mode. 

When E-E is ON, the input video signal is routed to the CVBS and SDI outputs of Channel 1.  
Manually toggle the E -E mode button OFF to switch the output to the disk, for conventional 
playback operation. 

Under automation control, Auto E-E behavior is slightly different than under GUI control.  
The server will remain in E-E ON mode until a transport control command (Play, Stop, Jog, 
etc) is received.  After receiving such a command, the server will remain in E-E OFF mode 
until the clip is ejected, a new clip is loaded, or record mode is entered.  In record mode, E -E 
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mode is ON.  As with GUI operation, automation controllers may send E -E ON and E -E OFF 
commands to override the automatic operation. 

Fast Forward / Rewind Buttons 
Fast Forward and Rewind buttons move the transport at high speed in the chosen direction.  
Four speed choices are available in each direction. Click the button repeatedly for: 4x, 16x, 
64x, and 128x.  Audio does not play at these speeds. 

Shuttle 
The Shuttle control is a slider bar where the center detent represents 0 speed, or Still.  The 
right and left extents of the slider represent ±2x maximums.  There are intermediate detents 
in each direction, representing a linear scale with 0.1x increments.  A display next to the 
slider shows the numerical speed value. 

This control plays the current clip in varispeed mode from 0 to ±2x (including a detent at 
±1x).   Because the shuttle control uses varispeed algorithms, even 1x varispeed may appear 
to occasionally skip frames. 

The Shuttle control slider works in three basic ways: Snap-Back to still, Hold Speed, and 
Mouse Wheel. 

• In Snap-Back operation, click and drag the slide control to change speed.  Releasing the 
slider bar will let it snap back to zero speed, or still. 

• For Hold Speed operation, position the cursor over the slider control scale (not the slider 
arrow) and click the left mouse button to increment the speed control.  The transport will 
run in the selected direction at the selected speed without holding the mouse button 
down.  The cursor may now be moved over the Stop button to wait for the desired point. 

• When using a scroll mouse, position the cursor over the slider scale and rotate the wheel 
to increment speed.  Rolling the wheel in opposite directions changes the direction the 
arrow slider moves.  To stop video, click the Stop button or the arrow slider. 

Jog Buttons 
The JOG + command will move to the next frame and go to Still.  The JOG - command will 
move to the previous frame and go to Still. 

GoTo Buttons 
In Edit mode, click the arrows ( |<, >| ) to go to the next trim point (Mark In or Mark Out) in 
the selected direction.  An additional click in the selected direction will go to SOM or EOM. 

In Play mode, click  |< or >| to go to Mark In and Mark Out points within the clip. 

Keyboard Shortcuts 
Many transport control and edit related functions can be performed by keyboard commands. 
A complete list of these appears in Appendix C. 
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Recording 
Video recordings are made on the Image Server using the Channel 1 section of the graphic user 
interface, or an external automation system.  Channel 1 can also be used for playback when not 
recording.   

Setting up to Record 
Image Servers were designed for use in genlocked facilities.  Both the server and video sources 
feeding it must be referenced to a common sync reference.  This signal should conform to RS-
170 (composite video, black).  When a genlocked source is not available, as in the case of 
satellite receivers or non-professional tape machines, a frame synchronizer can be used to 
create a synchronous source.1  Alternatively, the video output of a stable source can be 
connected to a distribution amplifier and applied both to the server genlock input and to its 
video input. 

Several steps must be taken before making a recording on the Image Server: 

1. A genlock signal must be applied to the rear panel Genlock connector. The server will not 
enter record mode if it does not detect the presence of a genlock signal.  The genlock input 
has a fixed 75-ohm termination.  Do not add another termination at any point on the 
genlock cable. 

2. The external genlock signal must be selected as the sync reference, using the On-Screen 
user interface. 

A. When working from the Serial Inputs, check the box marked SERIAL CONTROL.  
B. Eject any clip in Channel 1 and verify that the status window displays IDLE. 
C. From the main menu bar select CONFIGURE>SYSTEM.  
D. Select GENLOCK as the sync source. 
E. Click APPLY followed by OK.  The Configure window will close. 
F. Check that the front panel GENLOCK LED is now illuminated. 
 
Note: The INTERNAL  sync reference setting (a crystal) can be used for playback, but not 
for recording. 

3. A genlock signal must also be connected to equipment originating the video signal to be 
recorded on the Image Server.  (See introductory paragraph of this section if there is no 
provision for a genlock signal.) 

                                                 
1 Video frame synchronizers are available from a number of manufacturers from about $800. 
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4. The Image Server can accept a video signal at either its composite video input, or its serial 
digital (SDI) input.  Verify that the input to be used is currently active.  This selection is 
performed from the Configuration option on the Main Menu bar. 

A. Select CONFIGURE > CHANNEL 1… . 
B. On the Configuration screen that appears, select COMPOSITE or SDI. 
C. Click on APPLY or OK to confirm the selection and close the window. 
 

5. The Image Server records either two or four audio tracks according to a selection made in 
the Channel 1 Configuration window.  When a selection is made it will be saved for future 
recordings. 

A. Select CONFIGURE > CHANNEL 1… . 
B. On the Configuration screen that appears, select AUDIO 1-2, and/or AUDIO 3-4, 
or none if you do not wish to include an audio track. 
C. Click on APPLY or OK to confirm the selection and close the window. 
 

6. The Channel 1 configuration screen provides a number of other choices you may also wish 
to consider before making a recording.  These include: 

A. Select CONFIGURE > CHANNEL 1… . 
B. On the Configuration screen that appears, select CVBS / Discrete Audio, or SDI / 
Discrete Audio, or SDI / Embedded Audio. 
C. Click on APPLY or OK to confirm the selection and close the window. 
 

These topics are covered in detail in the System Configuration chapter of this book. 

Making a Recording 
When the steps outlined in “Setting up for Recording” (above) have been done, you are ready 
to record.  Channel 1 can be used for recording or playback, but not both at the same time. 
Before making a recording, channel 1 must first be placed in the Record Ready mode, which 
takes two seconds.  Once ready, any number of recordings can be made with no further delays.   

Perform the following steps to enter Record Ready and make a recording: 

1. When working from the On-Screen user interface, un-check the box marked Serial Control.  
When using an automation controller or other RS-422 external controller, check the Serial 
Control box. 

2. Open the Channel 1 transport window.  From the main menu bar, click 
TRANSPORT>CHANNEL 1, followed by CLIP.  This window contains all controls needed 
to make a recording.   

3. From the Channel 1 transport window click FILE>NEW.  A dialog box will open 
prompting you to name the new recording before making it.  In the lower window, enter 
the name you wish to give it, using up to 32 characters.  Spaces may be used; however, 
characters other than upper or lower case letters and numbers (i.e. @#$%&*) may not be 
used.  A list of existing clips will appear in the large window, and can be used as a name 
reference when creating new clip names. 
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Figure 9:  File Dialog Box 

 
4. After a brief pause, the time code digits will appear and the server is in Record Ready 

mode.  A recording can be started without further delay. 

5. Click the RECORD button.  It will turn red while recording.  

6. Click STOP when complete. 

7. The server will remain in Record Ready mode, and additional recordings can be made 
immediately by following steps 3 through 6. 

If the server is available for use as an ingest station, two methods are available for auditioning a 
new recording: 

• Channel 1 can play the recording immediately after it is made, but not during the recording 
process.  This approach is valuable if Channels 2 and 3 are in use for another purpose. 

• If Channel 2 or 3 is available, it can be used to play the recording while it is being made.  A 
short delay is required before a clip being recorded becomes available for playout. 

Notes: 

The maximum recording time for clips is about 12 hours.  The Image Server will stop recording 
and save the file at that time. 

If an error that would corrupt the clip is detected during recording, the Image Server will 
terminate the recording operation.  The clip will be saved, and will contain all material up to 
the point of corruption. 

Do not change the record configuration (bit rate, GOP structure, number of audio channels, 
etc) after a new clip is named and ready to record.  The configuration changes will NOT be 
applied to the cued recording.  Set up the record configuration before naming the recording. 
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Playing a Clip 
Clips can be played on any of the three channels of the Image Server , except that when Channel 1 
is used for recording, it is not also available for playback. 

Setting up for Playback 
The Image Server was designed primarily for use in genlocked broadcast facilities.  Both the 
server and video equipment following it should be referenced to a common genlock source.  
This signal should conform to RS-170 (composite video, black).  However, if the server is being 
used for playback in a non-genlocked facility, its internal sync reference may be selected. 

Perform the following steps before playing clips from the Image Server: 

1. If a genlock signal is distributed through the facility, it should also be connected to the 
server’s rear panel genlock connector.  This input has a fixed 75-ohm termination.  Do not 
add another termination at any point on the genlock cable. 

2. If an external genlock signal is available, it should be selected as the server sync reference, 
using the graphic user interface.   
A.  When working from the GUI, un-check the box marked SERIAL CONTROL. 
B.  Eject any clip in Channel 1 and verify that the status windows displays IDLE. 
C.  From the main menu bar select CONFIGURE >SYSTEM.  
D.  Select GENLOCK as the sync source. 
E.  Click APPLY followed by OK.  The Configure window will close. 
F.  Check that the front panel GENLOCK LED is now illuminated. 

3. If the server is installed in a facility where no genlock signal is available, the Internal Sync 
reference setting can be used for playback without genlock.  Follow the steps in item #2 
above, but select INTERNAL instead of GENLOCK.  In this case the front panel GENLOCK 
LED will not illuminate. Note that recording is not possible using the internal crystal as a 
sync reference. 

Playing a Clip 
When the steps outlined above in “Setting up for Playback” have been done, you are ready to 
play stored video clips.   

1. When working from the serial interface or automation controller, check the box marked 
SERIAL CONTROL.  

2. Open a Channel transport window.  From the main menu bar, click 
TRANSPORT>CHANNEL 1, followed by CLIP.  This window contains all controls needed 
to play a clip.   

3. From a Channel transport window click FILE>OPEN.  A dialog box will open containing a 
list of existing clips. Click on the desired clip name, followed by OPEN. 

4. The dialog box will close, and the channel transport window will show the selected clip 
name and running time.   
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Figure 10:  Selecting a Clip to Open 

 
5. Click PLAY to play the clip. 

6. Click STOP at any time. 

7. Additional clips can be played by following steps 3 through 5. 

Additional channel transport windows can be opened, and multiple clips can be played at the 
same time. 
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Editing a Clip 
The edit controls are activated with the Edit check box.  This region contains a number of buttons 
that define the beginning and end of a selected region, plus their associated time code displays. 

Non-destructive Mark In and Mark Out trim points can be set to define a portion of the clip to be 
played.  These “pointers” do not create a new clip from the original material; they act like virtual 
trims, and material outside of the trim points is excluded, but can be retrieved by resetting the 
Mark points.  After setting the Mark In and Mark Out points, clips will play between these points.  
These values are saved with the clip. 

Edits may be saved to the current clip by de -selecting the Edit check box, or choosing Save from 
the clip window File  menu.  Save As works to save the edit points to a new clip name, even if the 
edits have not been saved in the current clip.  This is a great help while conducting an Edit-while-
Recording. 

Edit-while-Recording 
While clips may be edited after recording is complete, it is often desirable to create sub-clips 
while the recording is still in progress.  This is the preferred way to get sports highlights, for 
example. 

To do this, open the recording on either Channel 2 or 3 by selecting the clip name from the  
File>Open menu (Note that recordings must be 10 seconds long before they appear in the clip 
list). 

Use the transport controls to select and mark the In- and Out-Points, as desired. 

Without un-checking Edit, select File>Save As, enter a new clip name, and click Enter.  A new 
clip is created that will play only from the In-Point to the Out Point.  This clip can now be 
played on the third channel, or assembled into a playlist. 

Now use the transport controls to locate the next desired In- and Out-Points and repeat the  
Save As command as many times as desired. 

As noted above, it is usually easier to leave the edit channel in Edit mode while you plan to 
make multiple “Saved As” clips.  If you de-select Edit, you will be given a choice to save or 
discard the edit points.  Remember that you will be saving the edits to the file that is currently 
being recorded. 

Mark In Button 
Sets the current time code value into the Mark In point time display.  The Mark In button can 
capture a time code value from the clip when it is still, or on-the-fly. 

Mark In Display 
Displays the time code of the Mark In point.  When no Mark In point has been set manually, 
this displays the default SOM time code (00:00:00:00).  Trim points will be automatically 
rounded down to the nearest GOP boundary when edits are saved. 

The values in this display window may be set by three methods: 
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• Trim Mark In point from the keyboard:  Use the mouse or keyboard arrows to move 
between fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Trim Mark In point with up/down arrows:  Use the mouse or keyboard arrows to move 
between fields.  When a field is highlighted, increment the up/down arrows (spin 
wheels) to change a numeric value. 

• Whether a clip is still or playing, press the Mark In button to capture a time code value 
from the clip. 

Mark Out Button 
Sets the current time code value into the Mark Out point time display.  The Mark Out 
button can capture a time code value from the clip when it is still, or on-the-fly. 

Mark Out Display 
Displays the Mark Out point time code.  When no Mark Out point has been set manually, 
this displays the default EOM time code (00:00:00:00). 

The values in this display window may be set by three methods: 

• Trim Mark Out point from the keyboard:  Use the mouse or keyboard arrows to move 
between fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Trim Mark Out point with up/down arrows:  Use the mouse or keyboard arrows to move 
between fields. When a field is highlighted, increment the up/down arrows (spinwheels) 
to change a numeric value. 

• Whether or not a clip is still or playing, press Mark Out to capture a time code value 
from the clip. 

Duration Display 
Displays the total running time (TRT) of the current clip.  For example, if the first frame of the 
clip is 00:00:00:00 and last frame displayed at the end is 00:00:01:15, the reported duration 
will be 00:00:01:16.  The difference between the time code of the last frame and duration is 
accounted for because this calculation is zero-based, and both the first and last frames play, 
so both are counted when calculating duration. 

With NTSC drop-frame time code, the displayed duration may not be the exact numerical 
value of ((Trim Out – Trim In) + 1) due to the discontinuities in the drop-frame time line. 

Review Clip Button 
The Review Clip button (|<–>|) cues the clip to the Mark In point (or SOM, if no Mark In 
point exists) and begins playback.  Review Clip will stop at the Mark Out point.  The Mark 
Out point will be displayed in Still mode. 

The Review Clip button may be used to check the Mark In point without playing all the way 
through the clip.  After Review Clip is pressed and play begins, all of the standard transport 
buttons are available for use. 
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Review Out Button 
The Review Out button ( –>| ) may be used to audition the Mark Out point without playing 
all the way through the clip.  It will cue the clip to three seconds before the Mark Out point 
(or EOM, if no Mark Out Point exists) and then begin playback.  Review Out will stop at the 
Mark Out Point. 

After Review Out commences, all of the standard transport buttons are available for use. 

Time Code Display of Edited Clips 
The GUI displays absolute time when in edit mode, and elapsed time, relative to the head 
point, once the edit has been saved. 
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Embedded Audio (Option) 

Introduction 
The Embedded Audio option for Image Servers is available as a factory-installed option, or 

as an update for certain models of Image Server already in service.  Embedded audio is based on 
SMPTE 272M-A. Key features include: 

• Synchronous 20-bit audio at a 48K sample rate.  Non-synchronous audio and other sampling 
rates are not supported.  

• While up to 16 channels of audio may be present in an SDI stream (arranged in 4 groups of 4 
channels), the Image Server records and plays back only Group 1 audio channels (channels 1-4).  

• In E-E mode, all embedded audio will pass through the Image Server unaltered.  

• The user can select audio to record from either a +4 analog, AES/EBU digital, or embedded 
audio source.  Mix-and-match among inputs is not supported. 

• Embedded audio is always included in the SDI stream on playback, and audio will 
simultaneously appear on the AES/EBU or analog audio outputs, as selected by the audio card 
option jumpers. When analog audio is selected, only channels 1 & 2 will be available at the 
output. 

• User bits in the SDI embedded audio stream are not supported. 

Setup 
A software key is required to enable the Embedded Audio option.  When purchased as a 

factory installed option, the Image Server will ship with the key already entered and the Embedded 
Audio option enabled.  It will also include a certificate that contains the unique key code used to 
enable Embedded Audio.  Store this document in a safe location for future use. 

If you have purchased Embedded Audio as an add-on to an existing Image Server, or if you 
need to re-enter the key code for any reason, use the following instructions to enable Embedded 
Audio. 

From the main Image Server GUI window, click on Configure > Options… 
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The following screen will appear: 

 

 

Figure 11:  Embedded Audio Configuration Window 
 

• Type the option key number supplied by 360 Systems into the Enter New Key text box. 

• Click on ‘OK.’   

• From the main GUI window, select START -> SHUTDOWN -> FULL RESTART to reset the 
Image Server.   

Embedded Audio is now enabled. 
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Configuration 
From the GUI window, click on Configure > Channel 1… .  The Channel Configuration 

window will appear.  Use this window to configure Embedded Audio. 

 

 

Figure 12:  Channel Configuration Window 

Input Source 
Three buttons select the input source for video and audio.  These are: 

• CVBS/Discrete Audio (composite video with AES/EBU or analog audio inputs) 

• SDI/Discrete Audio (serial digital video with AES/EBU or analog audio inputs) 

• SDI/Embedded Audio (serial digital video with embedded audio)  

The discrete audio inputs can be either: two stereo pairs (4 channels) of AES/EBU digital 
audio, or one stereo pair of +4dBu analog inputs, as determined by jumpers on the audio card. 

Regardless of the input selected, audio will always appear in the SDI output stream as 
embedded audio, and at the discrete outputs as either AES/EBU (digital) or as +4 dBu balanced 
analog audio.  The Image Server supports Group 1 embedded audio, which includes audio 
channels 1-4, 20-bit, 48 kHz, synchronous audio, as per SMPTE 272A. 
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Audio Sample Rate Conversion 
Two check-boxes are provided to engage built-in sample rate converters for either (or both) 

of audio channels 1 & 2, and 3 & 4.  When checked, the incoming AES/EBU audio tracks are 
converted to a 48K broadcast standard synchronized with video genlock.   

Note:  Audio sample rate conversion is not applicable for Embedded Audio and Audio Rate 
Conversion boxes will be grayed-out if the SDI/ Embedded audio check-box is selected, or if the 
XLR audio inputs are jumpered for analog audio. 
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DV Video and Graphics 
DV-format video and TARGA Graphics are standard equipment on Multi-Format Image 

Servers.  DV and Graphics is also available as an optional software accessory to extend the 
capabilities of the Image Server.  These features supports playout of DV-25 files in native format, 
and TARGA graphics files including those with key and fill.  DV and Graphics enables direct FTP 
import from Photoshop®, After Effects®, Final Cut Pro®, Xpress DV/Pro™, Liquid Edition and Vegas 
video. 

With DV and Graphics, the Image Servers are able to function as both a graphics still-store 
and an animation playout server.   Three simultaneous outputs give it the power to combine video, 
graphics and animation playback.  Channels 2 and 3 can be ganged to provide key-and-fill playout, 
while Channel 1 plays background video.  The following capabilities are included: 

Importing TARGA Graphics Files 
The Image Server will recognize and ingest single -frame TARGA files via FTP from most 
network-attached graphics workstations.  TARGA files have a .tga extension, and may contain 
an alpha (or key) channel.  During transfer, the Image Server will split the TARGA file into a Fill 
frame, and a Key frame if it exists.  These will be converted to high-resolution MPEG-2 files, 
one frame in length.   

For example, if an original file is named Logo.tga, the MPEG-2 files created will be named 
Logo.mxf (a fill file) and Logo_.mxf key (note the trailing underscore “_” added to the file name 
of the key.)  This allows the TARGA file  to be used for key and fill applications.   

Once a TARGA file is ingested, it exists only as an MXF MPEG-2 file.  The processed file may 
be transferred to-and-from network-attached storage, another Image Server , or a graphics 
workstation, as two separate  MXF MPEG-2 files. 

The resolution of a TARGA image should be 720x480 for NTSC video or 720 x 576 for PAL.  If 
the original TARGA image is not of this resolution, the Image Server will re-scale it, possibly 
introducing some dimensional distortion. 

Animation Import 
From the Image Server’s standpoint, an “animation” is a clip with a minimum length of two 
seconds.  A separate Alpha channel may or may not be present.  Any graphics workstation 
capable of exporting files supported by the Image Server can make transfers to it via FTP.  If an 
alpha channel is present, the naming conventions of the Key/Fill Mode apply.   Many software 
programs have the ability to create content compatible with the Image Server , including Final 
Cut Pro® 4, Avid® DV Xpress, DV/Pro, Liquid Edition, Vegas video, and Adobe® After Effects®, 
Premiere® and Photoshop®.  
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FTP File Transfers 
For standard FTP transfers, the Image Server will recognize the following file formats: 

TARGA (.tga) 
During transfer, the Image Server will split the TARGA file into a Fill frame and a Key (alpha) 
frame.  These two frames will each be converted to MPEG-2 files, one frame in length.  
See “Importing TARGA Graphic Files” (above) and “Key/Fill Mode” (below) for additional 
information. 

DV Stream (.dv) 
These are ‘elementary’ DV files containing a single stream of multiplexed audio and video.  
The Image Server will recognize and maintain .dv extensions on DV stream files, allowing 
transfer of .dv files between Image Servers and graphics workstations without modification.  
Only audio at 48K, 16-bit is supported. 

AVI Files (.avi) 
An AVI file is a container that encapsulates and describes a type of interleaved audio and 
video.  The Image Server will import Type 1 .avi files (a single stream of multiplexed audio and 
video) containing DV format video and 48K uncompressed audio.  During ingest of .avi files, 
the server will convert the file into a DV stream (.dv) for storage and future transfer. 

MPEG-2 (.mp2, mpg, mpeg, m2v) 
The Image Server will ingest valid MPEG-2 program streams or elementary streams.  The 
server’s ingest application will recognize a program stream that encapsulates a single MPEG-2 
video stream, and up to 2 stereo pairs of 16- or 24-bit, 48kHz, uncompressed audio.  16-bit 
audio files will be written into a 24-bit space.   

MXF - Material Exchange Format (.mxf) 
Transfer of MXF files between compatible products will be the preferred method of file 
interchange to-and-from an Image Server.  360 Systems supports ingest and playout of MPEG-2 
files based on SMPTE 377M, 378M and SMPTE 381M, Operational Patterns 1a and 1b. 

Key/Fill Mode  
When the “Gang to Ch2” box is selected in the Channel 3 transport control window, then a 
pair of key and fill channels will be ganged and played together.  Transport operations on 
Channel 2 will control both Channel 2 and Channel 3.  This allows the server to play locked, 
frame-accurate key and fill material (either stills or clips) on Channels 2 and 3.  Only a single 
channel of an automation controller is needed to play both the key and the fill. 
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Proper key and fill operation requires two clips of identical length, using the following naming 
convention: (the clip “myfile” is used as an example) 

Fill name:  myfile 

Key name (Alpha):  myfile_.  Note the underscore at the end of the key clip. 

When a clip is opened/cued on Channel 2, Image Server automatically looks for another clip 
with the same name, plus a trailing underscore.  If the clip is found, it is loaded on Channel 3.  
Typically, the Channel 2 clip contains the “fill” material, while the Channel 3 clip has the “key” 
(or alpha) file. 

An automation system, could, for example, issue a VDCP Cue command to Channel 2 for a 
clip called “logo”.  Channel 3 would automatically be loaded with clip “logo_”.  A Still or Play 
command sent to Channel 2 would cause both Channels 2 and 3 to display the fill and key 
clips, respectively. 

Note that the VDCP checkbox option to “show first frame” for a Cue command is ignored for 
channels in ganged mode.  The automation system must issue a Still command to Channel 2 to 
achieve this effect. 

Ingesting a TARGA file via FTP automatically creates a key clip and a fill clip, each a single 
frame in length.  For example, if file “xyz.tga” is transferred to an Image Server via FTP, then a 
pair of single-frame clips is created:  “xyz” and “xyz_” containing the fill and key material.

Still Frames 
A single-frame clip (a “still”) may be inserted into a playlist.  The length of a still will appear as 
one frame in the clip list.  When a still is encountered, the playlist will pause and hold the still 
image until a Play command is issued, at which point the playlist will continue to the next clip 
in the list.  When using the GUI, the space bar (a keyboard shortcut) will also advance the 
playlist.  Stills may be placed anywhere in a playlist.  In fact, a playlist may be entirely 
composed of stills.   

Stills are created when TARGA files are ingested.  (See Page 51 for a description of TARGA file 
ingest.)    
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Advanced Playlisting 
360 Systems’ new Advanced Playlisting software provides an extensive set of capabilities 

for building, editing and playing complex sequences of program content to be played on an Image 
Server.  Advanced Playlisting appears as on-screen windows, with a clean Graphic User Interface 
that makes it easy to run with no extra equipment.  It’s invaluable for building commercial breaks, 
news rundowns, still-store and clip lists.  You can create and store as many playlists as needed, 
each with its own unique name.  For many users, Advanced Playlisting may be everything you’ll 
need to go to air. 

 
Figure 13:  Play List and Clip List Windows for Advanced Playlisting  

 

Advanced Playlist Features and Benefits 

Ø Drag-and-drop playlist building and editing on a graphics interface  
Ø Edit lists while they’re running 
Ø Start at any point in a list 
Ø Displays run time for clips, plus segment length and total remaining time 
Ø On-the-Fly commands for Pause, Skip, Hold, Next and Jump functions 
Ø Six programmable GPI output events embedded in playlist clips 
Ø Programmable time-of-day start for a playlist 
Ø Generates an As-Run Log 
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Figure 14:  Screen Shot of Playlist Window 

 

The Playlist Window 

Advanced Playlisting appears as an on-screen window, accessed by clicking 
Transport>Channel…> Playlist.  It presents the following information displays, time displays, 
control buttons and check-boxes to the user: 

1. Title Column 
The title column displays all clips contained in a playlist, with the first-to-play at the top. 
Clip names of up 32 characters are supported. 

2. Duration Column 
The clip length is displayed in hours/minutes/seconds/frames. 

3. Time Remaining Column 
Time Remaining indicates when a currently playing clip will finish. 

4. Status Column 
Status refers to what has taken place, is now taking place, or will take place with regard to 
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each clip. 
 
BLANK WHITE CLIP IS AVAILABLE TO PLAY 

CUEING PURPLE CLIP IS TRANSITIONING TO A CUED STATUS. MAX TRANSITION TIME IS 4 SEC. 

CUED YELLOW CLIP IS READY TO PLAY ON COMPLETION OF TH E PRECEDING CLIP, OR WHEN THE 
PLAYLIST STARTS, IF NOT PRESENTLY RUNNING. 

PLAYING GREEN CLIP IS ACTUALLY PLAYING. 

DONE GRAY CLIP HAS PLAYED COMPLETELY, FROM FIRST FRAME TO LAST FRAME. 

MISSING RED CLIP WAS NOT FOUND 

CLIPPED GRAY CLIP BEGAN PLAYING, BUT DID NOT COMPLETE 

PAUSED GREEN CLIP HAS BEEN PAUSED. FURTHER, WHEN PAUSE IS ASSERTED THE PLAYLIST IS 
NOT ADVANCING. 

SKIPPED GRAY CLIP WAS SKIPPED, EITHER BY A NEXT OR CUE OPERATION , OR BECAUSE THE 
SKIP CHECKBOX WAS SELECTED. 

 

5. Item Column 
This left-most column displays sequential clip numbers within a playlist, and also a SKIP 
checkbox which, when un-checked, will skip over a clip, while leaving it in the playlist. 

6. GPO Column 
The GPO column shows whether a general-purpose control output, (number 1 through 6) is 
programmed to become active during playout of a clip.  (An Image Server provides six GPI 
outputs on a rear panel connector, which may be used to control switchers, character 
generators or other devices.) 
 

Time Displays, Buttons and Check-Boxes 

The following buttons and check-box icons also appear in the Playlisting window: 
 
PLAY / PAUSE (toggle) 
When a Playlist is stopped, PLAY will cause the currently cued clip to play from its start.  When the 
Playlist is in PAUSE mode, PLAY will cause the Playlist to resume playing from the current 
location.  PAUSE stops the Playlist immediately, on the current frame of a clip. 
 
STOP/SHOW 
The Playlist will stop and video will go to black.  The current clip will be re-cued from the 
beginning. When a clip is cued, the button legend changes to SHOW.  Pressing it will display the 
first frame of the cued clip. 
 
CUE 
When a Playlist is running, CUE immediately prepares a selected clip for playback. 
When the current clip is finished playing, the Playlist will play the Cued clip, followed by all 
subsequent clips.  This allows the user to jump over clips.  The user may also re-cue a clip that has 
already been played.  In this case, the Playlist will restart from the selected clip, and all subsequent 
events will be re-played in sequence. 
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NEXT 
While a Playlist is stopped, NEXT will prepare the next clip in the Playlist for playback.  While the 
Playlist is running, NEXT will immediately begin playing the next clip in the Playlist. (The next clip 
may require several seconds to load and cue for a seamless transition.)   
If the next event in the Playlist is a HOLD, the NEXT command will move to the Hold event, and 
video will display black. 
 
JUMP 
Cues a selected clip for immediate playback.  This allows the user to jump over clips, and clips that 
have been already played can be re-cued.  In this case, the  Playlist will restart from the selected 
clip, and subsequent events will be re-played in sequence. 
 
H (HOLD) 
Inserts a HOLD event in a playlist immediately before the selected clip.  The HOLD command is 
also available in the Playlist Item Context Menu, accessed by clicking in the playlist item window.  
The PLAY or JUMP command will restart a playlist after it has stopped on a HOLD line. 
 
HOME  
In the event the user has scrolled a distance up or down in the List to perform some action, and 
then wishes to again make the currently-playing clip visible in the List View window, HOME will 
do this, and will also maintain the currently-playing clip within the window, if EDIT is off.  If no 
clip is playing, then the currently-cued clip is selected. 
 
Segment Time Remaining Window 
This window displays time remaining from present until the next HOLD command in the list. 
 
Total Time Remaining Window 
This window displays the total time of all clips that remain unplayed, including the present one. 
 
Scheduled Start Time Window 
This window can display a scheduled (time of day) start time for a playlist. When armed to start or 
actually running, the time in this window appears in red.  Click on any of the hours, minutes, 
seconds or frames fields to edit it.  Use the left and right arrow keys to change fields. 
 
Play On Schedule checkbox  
If a Scheduled Start Time has been entered, checking this box will arm it to begin at that time. This 
box will automatically un-check itself after a scheduled start has commenced. 
 
Loop checkbox  
When checked, the Image Server will loop the entire playlist after the last clip completes. Upon 
un-checking, the list will play to completion and then playback will stop. 
 
Edit checkbox 
Editing operations can only be performed when the Edit box has been checked. This box protects 
the playlist content from accidental modification.  When EDIT is on, the playlist window does not 
automatically track the currently playing clip. 
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The Clip List Window 

The Clip List window displays all clips that are available on the Image Server, including title, 
duration, and video format.  The Clip List Window is the source for all clips used to build a playlist 
in the adjoining Playlist window.  

 
Figure 15:  Clip List Window 

 

Clip List Window 

To open the Clip List window, click Window>Clip List on the Main Menu Bar. A clip may be 
dragged from the Clip List window to a position on the playlist.  The following rules will be helpful 
when using drag -and-drop: 

• Drag-and-drop only works when a Playlist is in the edit mode (EDIT checkbox is checked). 
• When a clip is dropped, it will be inserted in the Playlist ABOVE the clip it was dropped 

over, and will occupy the event number of that clip. 
• Clips can be rearranged within a Playlist using drag-and-drop. 
• Clips can also be dragged from other Playlist windows.  To do this, the target Playlist must 

be enabled for editing. 
• Clips cannot be inserted before a clip that is scheduled to begin playing within the next 

four seconds (approx). 
• Drag-and-drop also works while a Playlist is running. 
• To copy a clip within a Playlist, hold the Ctrl key while selecting and dragging the clip.  
• Multiple non-consecutive clips can be selected by holding the Ctrl key as you click. They 

will insert into the list in alphabetical order. 
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• An entire range of clips can be selected by holding the Shift key and clicking two clips. 
 
The following suggestions for advanced users apply to working in the Clip Window when only one 
Playlist is enabled for editing: 

• Double-clicking a clip will append it to the end of a Playlist, if the Playlist’s Edit Box is 
checked. 

• The Enter key will append a selected clip to the end of a Playlist if its Edit Box is checked. 
 
Programming GPI Outputs 

The Image Server has six General Purpose Interface outputs, referred to as GPO 1 through GPO 6.  
Any of these can be programmed to go active at a predetermined time, or Offset, after the 
beginning of a Playlist clip.  An active Duration can also be set, after which the output again goes 
inactive.  In all cases, every output will go inactive when a clip ends.  By default, a new clip 
contains no programmed GPI output commands. 

Information on interfacing to GPI outputs will be found in Appendix A of the Image Server 
Operations Manual. 

 
Figure 16:  GPI Output Editor Window 

 

To configure GPI output events for a Playlist clip: 

• Open the Playlist for editing: Click the Edit check-box. 
• Right click on the clip to which you wish to assign GPI output events.  Select the Edit 

GPO… command from the Playlist Item Context Menu.  The GPO Editor window will 
appear.  Note that you cannot otherwise edit a Playlist while the GPO Editor window is 
open. 
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• Enable one or more desired GPI outputs, numbers 1 to 6, by checking its checkbox. 
• Select the GPO Offset with the mouse or by using the arrow keys on the keyboard (see 

GPIO Editor Keyboard Shortcuts below).  The Offset is a positive time value that determines 
how long after the beginning of a clip its GPI output will become active. 

• Select the GPO Duration by using the mouse or the arrow keys. 
• Repeat the steps above for every output to be configured. Click the Apply button to make 

the changes active and close the window.  
 
GPI Output Editor Keyboard Shortcuts 
 
Tab Cycles the keyboard focus through all buttons and numeric windows. On the GUI 

each button, or other item that can be controlled by a keyboard command, will 
appear surrounded by a dotted line. 

 
Right Arrow Same as Tab, except it will also advance through individual timecode fields. 
  
Left Arrow Same as Right Arrow, except it cycles in the opposite direction. 
 
Up Arrow Increments the hours, minutes, seconds or frames field of a timecode window when 

it has the keyboard focus. 
 
Down Arrow Decrements the hours, minutes, seconds or frames field of a timecode window 

when it has the keyboard focus. 
 
Enter Toggles the enabled/disabled state of a GPI output.  This is the equivalent of 

checking or un-checking the Enabled checkbox. 
 
Programming GPI Inputs 

 The Image Server also provides six programmable GPI inputs, which can be used to initiate 
playback of playlists, individual clips, and multiple groups of clips. Collectively, the server’s GPI 
inputs and outputs present a powerful and universal interface to switchers, character generators 
and other equipment.   
 Instructions for programming GPI inputs will be found in the System Configuration chapter.  
 
Playlist Window Keyboard Shortcuts 

Tab Cycles the keyboard focus through all buttons and numeric fields. 
C CUE 
E Toggle Edit checkbox 
H HOLD 
J JUMP 
L LOOP 
N NEXT 
P / Space PLAY 
S STOP 
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T Toggle Arm Start Time checkbox 
HOME HOME 
ENTER / RETURN Invoke the Playlist Item Context Menu 
OPEN PLAYLIST WINDOW ALT 1, ALT 2 or ALT 3 

The As-Run Log 

The Image Server’s Advanced Playlisting software is able to generate a log of all files played during 
the execution of a playlist, within a 24-hour day.  This data can be exported via Ethernet to an 
external computer.  As-Run logs are used in management and billing to document that 
commercials or programs were actually played.  

Enabling As-Run Logs 
To turn on As-Run logs, open a Playlist window, select Options, then click on As-Run Logs.  
When turned on, a check mark will appear next to the As-Run log label.  Once enabled, any 
files played by a playlist will be written to an As-Run log. 

As-Run logs are available only through FTP downloads.  After logging into an Image Server, 
select the ASRUN folder.  All logs are stored in this location, and have the extension “.arl”. 

Sample As-Run Log 
IS-76152 as-run (Ch2:KQRS) Engr Wed Feb 02, 2005 [Wednesday PM]          Pg 1 

   1  10:54:40   00:00:05:00   KRBE ID - Legal            PLAYED OK 
   2  10:54:45   00:00:30:00   Cellular One – Talk Time      PLAYED OK 
   3  10:55:15   00:00:30:00   Burger Stop – 2 for 1            PLAYED OK 
   4  10:55:45   00:00:15:00   Promo – Friends - Today     PLAYED OK 
   5  10:56:00   00:00:30:00   Bank of America – Gold Years                PLAYED OK 
   6  10:56:30   00:07:18:05   RICKI WEDNESDAY – SEG 1       PLAYED OK 
 

As-Run Log Page Header 

This section describes the format of the first line (page header): 
IS-76152 as-run (Ch2:KQRS) Engr Wed Feb 02, 2005 [Wednesday PM]          Pg 1 

IS-76152:  IS-XXXXX, where XXXXX is the unique machine ID.  This is the same ID that is 
used to create keys for optional software. 

As-run (Ch2:KQRS):  ChX is the channel number and KQRS is the name of the specific 
channel, as defined in the Configuration System window. 

Engr:  The name of the Image Server, as defined in the Configuration System window. 

Wed Mar 30, 2005:  The base date to which clip times are referenced. 

[Wednesday PM]:  The name of the playlist 

Pg 1:  The page number of the printout.  
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As-Run Log Body 
This section describes the format of the body of an As-Run log: 
2  10:54:45   00:00:30:00   Cellular One – Talk Time      PLAYED OK 

 
2:  The line number (order) of the clip as it appears in the playlist. The same clip could have 
multiple numbers as files are added or deleted. 

10:54:45  The time at which the clip was played in HH:MM:SS, on a 24-hour clock. 

00:00:30:00  The length of the clip in HH:MM:SS.FF, on a 24-hour clock. 

Cellular One – Talk Time:  The name of the clip. 

PLAYED OK:  The status of the played clip.  Other possible status conditions are CLIPPED 
(meaning less than its full length played); SKIPPED (meaning it was skipped over); and 
STOPPED (meaning it was stopped during playout.   

Configure System - Names 
The name for a particular Image Server, and its three video channels, can be set using the 
Configure>System>Names tabs of the main menu bar. Select OK or Apply after entry. 
These names will appear on all subsequently generated As-Run logs. 

 

 

Figure 17:  Screen Shot of Name Configuration for Image Server 
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FTP Transfer of As-Run Log 
 

The As-Run logging function within Advanced Playlisting can be turned on or off. In the 
Playlist window, select Options>As Run.  When the playlist is run, all clips played, clipped 
or skipped are logged to a text file.   

The file is accessed by logging on to the Image Server’s FTP service and opening the folder 
AsRun.  The As-Run log contained in it can be transferred from an Image Server to another 
computer using standard FTP transfer tools.  The FTP window can be treated like any other 
Windows Explorer window. 

Using Microsoft Internet Explorer, FTP into the Image Server.  A folder named “asrun” will 
be listed in the Directory Contents.  To copy the As-Run log to you computer, double click 
on the ‘asrun’ folder.   

 

Figure 18:  Screen Shot of As-Run Folder in Image Server Directory 
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As-Run logs are located in this folder, as shown below.  Right-click the file to be transferred, and 
choose either “Copy to Folder…” or “Copy” from the drop-down menu.  Windows will then prompt 
you to select a file folder in which to store the log.  Alternative FTP programs will provide similar 
transfer means. 

 

Figure 19:  Screen Shot of As-Run .arl Files 

As-Run Log Naming Convention 
Using the file “0225.1_test3.1.arl” as an example, the As-Run naming convention is as 
follows: 

0225: The month and day (Feb 25) on which the playlist was opened for playout. 

1: The Image Server channel on which the playlist was played. 

test3: The name of the playlist. 

1: The instance of the playlist.  Each time you open a single playlist more than one time 
in a single day, this number will automatically increment to maintain unique filenames.  

arl: The file extension designating a 360 Systems Image Server As-Run log file. 

Note:  “.” and “_” are used as delimiters within the As-Run log file names. 
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Editing a Clip 
 

Although not a part of Advanced Playlisting, the Image Server provides accurate tools for trimming 
the head and tail of a clip.  Trimming and playlisting together allow the Image Server to create 
accurate and complex rundowns.  Trims do need to be performed before inserting a clip into the 
playlist.   

The edit controls are activated with the Edit check box on each channel’s GUI window.  This 
region contains a number of buttons that define the beginning and end of a selected region, plus 
their associated time code displays. 

Non-destructive Mark In and Mark Out trim points can be set to define a portion of the clip to be 
played.  These “pointers” do not create a new clip from the original material; they act like virtual 
trims, and material outside of the trim points is excluded, but can be retrieved by resetting the 
Mark points.  After setting the Mark In and Mark Out points, clips will play between these points.  
These values are saved with the clip. 

Edits may be saved to the current clip by de -selecting the Edit check box, or choosing Save from 
the clip window File  menu.  Save As works to save the edit points to a new clip name, even if the 
edits have not been saved in the current clip.  This is a great help while conducting an Edit-while-
Recording. 

Mark In Button 
Sets the current time code value into the Mark In point time display.  The Mark In button can 
capture a time code value from the clip when it is still, or on-the-fly. 

Mark In Display 
Displays the time code of the Mark In point.  When no Mark In point has been set manually, 
this displays the default SOM time code (00:00:00:00).  Trim points will be automatically 
rounded down to the nearest GOP boundary when edits are saved. 

The values in this display window may be set by three methods: 

• Trim Mark In point from the keyboard:  Use the mouse or keyboard arrows to move 
between fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Trim Mark In point with up/down arrows:  Use the mouse or keyboard arrows to move 
between fields.  When a field is highlighted, increment the up/down arrows (spin 
wheels) to change a numeric value. 

• Whether a clip is still or playing, press Mark In to capture a time code value from the 
clip. 

Mark Out Button 
Sets the current time code value into the Mark Out point time display.  The Mark Out button 
can capture a time code value from the clip when it is still, or on-the-fly. 
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Mark Out Display 
Displays the Mark Out point time code.  When no Mark Out point has been set manually, 
this displays the default EOM time code (00:00:00:00). 

The values in this display window may be set by three methods: 

• Trim Mark Out point from the keyboard:  Use the mouse or keyboard arrows to move 
between fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Trim Mark Out point with up/down arrows:  Use the mouse or keyboard arrows to move 
between fields. When a field is highlighted, increment the up/down arrows (spinwheels) 
to change a numeric value. 

• Whether or not a clip is still or playing, press Mark Out to capture a time code value 
from the clip. 

Duration Display 
Displays the total running time (TRT) of the current clip.  For example, if the first frame of the 
clip is 00:00:00:00 and last frame displayed at the end is 00:00:01:15, the reported duration 
will be 00:00:01:16.  The difference between the time code of the last frame and duration is 
accounted for because this calculation is zero-based, and both the first and last frames play, 
so both are counted when calculating duration. 

With NTSC drop-frame time code, the displayed duration may not be the exact numerical 
value of ((Trim Out – Trim In) + 1) due to the discontinuities in the drop-frame time line. 

Review Clip Button 
The Review Clip button ( |<–>| ) cues the clip to the Mark In point (or SOM, if no Mark In 
point exists) and begins playback.  Review Clip will stop at the Mark Out point.  The Mark 
Out point will be displayed in Still mode. 

The Review Clip button may be used to check the Mark In point without playing all the way 
through the clip.  After Review Clip is pressed and play begins, all of the standard transport 
buttons are available for use. 

Review Out Button 
The Review Out button ( –>| ) may be used to audition the Mark Out point without playing 
all the way through the clip.  It will cue the clip to three seconds before the Mark Out point 
(or EOM, if no Mark Out Point exists) and then begin playback.  Review Out will stop at the 
Mark Out Point. 

After Review Out commences, all of the standard transport buttons are available for use. 

Time Code Display of Edited Clips 
The On-Screen interface displays absolute time when in edit mode, and elapsed time, 
relative to the head point, once the edit has been saved. 
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Automation Control 
Image Servers can be controlled by leading broadcast automation systems, instant replay 

panels, video switchers, and many remote control devices.  The Image Server accepts VDCP, P2, 
and Odetics commands generated by most automation systems, on three 9-pin connectors.  To 
provide compatibility with simple controllers and push buttons, the server also provides GPI 
(contact closure) inputs, and programmable command outputs. 

Remote Serial Control 
The Image Server’s three 9-pin serial control ports allows independent control of its video 

channels.  Each port can respond to channel ID numbers that are equal to, or multiples of, its base 
number.  For example, channel 1 will also respond to 4, 7, 10, etc.  This can be helpful when 
automation system needs to control many Image Servers at once.  

Only one serial controller can control a video channel at a time.  For example, the Image 
Server’s multiple serial ports allow simultaneous connection of an automation controller and a 
desktop editing controller.  In this way, one could configure an edit controller on Channel 1 for 
record, playout, and editing, while an automation controller on Channel 2 manages play-to-air 
operations.  Alternatively, a single controller could control the operation of all Image Server 
channels. 

Controller Priority 
When the Serial Control box is checked, the first controller to gain control of a video channel will 
have exclusive command.  This prevents conflicting instructions from causing unexpected 
behavior.  However, a local user may take control of a channel by de-selecting the Serial Control 
check box in that channel’s dialog window.   A GUI window will pop up, indicating that the user 
is about to take control from the Serial Port.  Select YES to take control.  The user may also take 
control of the channel by selecting Control > Take Control from the Transport menu. 

Many remote control protocols do not provide a method to send a “disconnect” message to the 
Image Server, or communication might be lost before a disconnect command is received.  This 
may make it difficult for more than one controller to share a video channel.  If a channel becomes 
locked to a controller, you may use the GUI channel control window to break the lock by 
deselecting Serial Control mode.  Another controller may be connected to the channel by selecting 
Serial Control and sending the new connect commands from the remote controller. 

Communication Protocol Setup 
Image Servers support VDCP, P2 and Odetics command protocols.  Set the desired protocol for 
each server serial port with the Serial Ports dialog box of the GUI, as shown in the following 
illustration.  From the main menu, select Configure, then System, then the Control tab. 
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Figure 20:  Control Protocol Setup Window 

VDCP Options  
As illustrated in Figure 13, a number of check boxes are provided that control how the Image 
Server will respond to certain VDCP commands.  Once set, these options remain selected when 
the server is turned off, and until changed by the user. 

Cue Shows 1st Frame 
Upon receiving a Cue With Data or a Play Cue command, the server will cue the clip then jog to 
and display the first frame of video. 

Cue with Offset (vs. Timestamp)  
When checked, the time code for the clip becomes “zero-based” with reference to the head point.  
To move to the head point of the clip, the automation controller would send a time code value of 
00:00:00:00, regardless of the clip’s original time stamp.  When unchecked, the Image Server  will 
calculate time code position based upon the time stamp from the first frame of the original, 
unedited clip.   

Vari-Play 1X Equals Play 
Image Server will interpret a Vari-play 1x command as a Play command. 

Vari-Play 0 Equals Pause 
Image Server will interpret a Vari-play 0x command as a Pause command. 
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Report Play (vs Still) At End 
When the end of the clip is reached, Image Server will report Play to the automation controller, 
instead of Still. 

Ignore Preroll Commands 
The default value for Image Server’s Preroll time is 10 frames.  Automation controllers generally 
have the ability to set this value in their own configuration menus, negating a need to adjust this 
value dynamically.  This box should typically be checked. 

Auto E-E 
Toggles Auto E-E mode. 

Communication Port Parameters 
The serial data transfer parameters for the Image Server are fixed, and cannot be changed.  These 
characteristics are common to all automation controllers: 

 
Baud Rate 38.4 K Baud 

Start Bits 1 

Data Bits 8 

Parity Odd 

Stop Bits 1 

Tested Automation Controllers 
The Image Server has been tested by 360 Systems and manufacturers of equipment listed below, 
and found to operate correctly .  This list is not comprehensive, and the inclusion or absence of a 
product does not indicate a preference for any make or model.  Operational variations do exist 
between makes and models.   

 
Manufacturer Controller Protocol Notes 

HARRIS AUTOMATION  ADC-100 VDCP ALL HARRIS CONTROLLERS SAME 

SUNDANCE DIGITAL FAST BREAK VDCP  

NVERZION EMC-NT  VDCP  

CRISPIN CORP. SYSTEM 2000 VDCP  

FLORICAL AIR BOSS VDCP  

DTG  AIRO VDCP  

LEIGHTRONIX TDC/IP VDCP  

TIGHTROPE MEDIA  CABLECAST P2  

HARDATA HDX VIDEO ODETICS ARGENTINA / SOUTH AMERICA  

THOMSON-PARKERVISION PVTV-PLUS NEWS VDCP ALL CR SERIES 
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Tested Remote Control Panels and Switchers 
The Image Server has been tested by 360 Systems and manufacturers of the remote control devices 
and video switchers listed below, and found to operate correctly.   

 
Manufacturer Controller Protocol Notes 

ROSS V IDEO SYNERGY® SWITCHERS VDCP  

DNF CONTROLS 4000-CL VDCP ALSO USED WITH DNF SHOT BOX 

DNF CONTROLS 300-SSM P2 BVW-75, ALSO ODETICS PROTOCOL 

ASH VALE  SM-2 P2 SLOW MOTION CONTROLLER 

BUF VTC-4000 P2 BVW-75, ALSO ODETICS PROTOCOL 

BUF SPOT VDCP ALSO ODETICS PROTOCOL 

LANCE DESIGNS TDC-100 ODETICS  

HI-TECH  SYSTEMS ACTIV CART BOX VDCP ALL VDCP PRODUCTS SAME 

 
The Image Server can play video with seamless transitions from all three outputs. (Earlier software 
versions had 2-channel modes and 3-channel modes; software upgrades now produce gap-free 
playback under all conditions.)  A 10-frame pre-roll is required to allow the server time to access 
video data for playback. 
 

Uses for Extra Server Ports 
If a video port on the server is not designated for a purpose, there are several good uses it may be 
put to that take only a small amount of extra work and resources, and enhance overall system 
capability:  

• A fully functional, wired, and running backup channel in the event of a problem on a video 

output. 

• A preview channel for independent browsing/viewing of a clip. 

 

Concurrent Playback 
All clips on an Image Server can be accessed concurrently by multiple applications.  This means 
for example, that a clip can be played on multiple channels; may be played while recording; or 
may be transferred to another machine while playing.  This can also be done on multiple channels, 
allowing a single clip to play concurrently with several different offset times. 

Download from Www.Somanuals.com. All Manuals Search And Download.



 

74 = System Configuration 

 
System Configuration 

There are many configuration settings available in the Image Server 2000 and the Multi-
format Image Server.  The location of each group of settings is associated with its usage.  Generally, 
there are two types: System and Channel.  The Date/Time setting applies to the entire system, but is 
accessed directly from the Configure menu.  Channel configuration settings are separated into 
Input and Output groups. 

Setup configuration menus can be accessed from the Main Menu > Configure choice. 

System 
Open this dialog window to configure general control and sync parameters, such as GPI, sync, 
time code, and video standards.  See System Configuration Options  below for more 
information. 

Options 
Optional features purchased along with Image Servers include a certificate with a unique 16-
digit Key code.  Keep this certificate in a safe location.  While optional features are generally  
installed and activated at the factory, the Key code will be required should you ever need to 
perform a fresh software install on your Image Server.   If you purchased an optional feature 
(such as Embedded Audio or DV and Graphics), separately from your Image Server, a 
certificate will be included with your updated software.  To enable purchased options, select 
Configure > Options… and enter the Key value found on the included certificate.    

 

 

Figure 21:  Configure Options Window 
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Date/Time 
Open this dialog window to set the Image Server internal system date and time.  This 
information will be used to time stamp the data files of new recordings.  All channels must be 
idle to change the Date/Time setting . 

Channels  
Select a video channel from this dropdown menu to configure channel-specific audio, video, 
and time code parameters.  For more information about changing channel setups, see Channel 
Configuration on page 82. 

Many options are presented on a single screen.  Some choices logically exclude others.  When 
making certain selections, other selections may become available, unavailable, or have 
different range limits.  Options that become unavailable will be grayed out. 

To accept changes made to the configuration dialog box, click Apply.  Click OK to accept 
changes and close the configuration dialog window.  Click Cancel to close the window and 
discard any changes.  Changes will become effective when the channel starts the next (new) 
recording. 

System Config Options 
The Configure System dialog box contains several tabs that organize general machine settings: 

Timing Tab 
Select the Timing tab to configure the following parameters: 

System Parameter Value 
Video Sync Genlock, Internal 

Genlock Timing Lines: -4 to +12 
Pels: -200 to +200 

Output Mode 2- or 3-Channel 
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Figure 22:  System Timing Configuration Window 

Video Sync 
During normal operation, the Image Server must be referenced to an external genlock 
reference in the form of CVBS Black.  A BNC connector is provided for this purpose on the 
rear panel.  An internal crystal reference is also provided when Image Server is used as a 
stand-alone player, or for convenience in performing tests in the laboratory. 
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The front-panel Genlock indicator provides the following information: 

If the external sync reference is good, the Genlock indicator will light. 
If the external sync reference is bad, the Genlock indicator will blink. 
If the internal reference is selected, the Genlock indicator will not light. 

Recording is not possible without an external Genlock reference. 

Video Format 
The Image Server is delivered in different models for NTSC or PAL.  Files can only be played 
by the machine model for which they were recorded. 

Genlock Timing 
Upon selecting the external sync reference, the video timing may be adjusted in terms of 
lines (H sync) and pels (pixels) with reference to the external sync. 

Color Framing 
The Color Framing toggle setting allows all channels to achieve the correct color frame 
sequence.  Image Server’s video channels are always correctly aligned with respect to each 
other; however, after cycling power, color framing could be out of phase with reference to 
the external genlock input. Color framing errors may appear as brief horizontal image shift 
when switching between separate video sources. 

NTSC Models:  The Color Framing toggle button advances the phase of all channels by 180 
degrees with respect to the external genlock signal.  

PAL Models:  The Color Framing toggle button advances the phase of all channels in 90 
degree increments, with respect to the external genlock signal. 

The Color Framing toggle setting is retained during a warm reset (i.e. by selecting “Reboot 
Image Server” from the GUI Start menu), but is not restored after a cold shutdown (by either 
selecting “Halt Image Server” from the GUI Start menu, or powering down the Image Server 
by pressing the front panel power switch).  In the case of a cold shutdown, Color Framing 
may need to be toggled to properly align with the external genlock input. 

The Color Framing toggle setting will have no visible effect when Video Sync is set to 
Internal. 
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GPI Inputs, Programming 
Six GPI inputs are available for remote control of Image Server functions. Each is internally 
pulled high to +5 volts, and is active when pulled to ground through a contact closure.  

Two drop down menus provide independent selection of control functions and channel 
assignments for each GPI input.  Assignable functions include Play, Stop, Re-cue, Record, 
and Pause. Each may be mapped to Channel 1, Channel 2, Channel 3, Channels 1+2, 
Channels 2+3, or Channels 1+2+3. 

 

 

Figure 23:  GPI Input Configuration Window 

Download from Www.Somanuals.com. All Manuals Search And Download.



 

  System Configuration = 79 

GPI Outputs, Programming 
Six GPI outputs are available for use as tally or status indicators, driving an LED or logic 
input. Outputs are open collector, active low. 

Two drop down menus provide independent monitoring for each output.  Available status 
parameters include Idle, Playing, and Recording.  Each of these states may be monitored for 
Channel 1, Channel 2, Channel 3, Channels 1+2, Channels 2+3, or Channels 1+2+3. 

 

 
Figure 24:  Output Configuration Window 

 

The GPI connector pinout will be found in Appendix A. 

 

Control 
Descriptions of Control features may be found in the Automation Control section starting on 
page 69. 

Time Code  
The Image Server supports only drop frame time code for NTSC operations. 
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Figure 25:  System Time Code Configuration Window 

Names 
The Main Image Server GUI window and each of the individual Channel windows may be 
assigned unique names.  This is especially useful when using either the Remote GUI or 
operating multiple Image Servers from a single computer monitor (using a KVM switch). 
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Figure 26:  Configure System Names Window 

Network 
A complete description of the Network window may be found in the Configuring Network 
Settings section beginning on page 99. 
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Channel Configuration 
Input channel configuration pertains to recording processes, which take place on Channel 1. 
Output configuration pertains to playback variables, and can be set individually for each of the 
three server channels. 

Changes made to recording parameters are recognized by the server the next time a clip is created 
(from the GUI, when FILE>NEW>CREATE is invoked).  If the bit rate is changed, for example, 
after creating the clip name, but before recording, the change will not be applied to this recording.  
Do not make changes to a recording’s characteristics after you have initiated it.  

Input Configuration 
The factory default settings for Input Channel Configuration are presented for reference.  
Most of these video encoding options will be suitable for general broadcast operations, but 
may not be optimum for contribution content or low bit rate use. 

 

INPUT SOURCE CVBS  MPEG-2 PROFILE 4:2:2 
     
TRACK ARM   GOP STRUCTURE I-FRAME 

Video ON    
Audio 1-2 ON  BIT RATE 25 
Audio 3-4 OFF    
CC OFF    

     
AUDIO Sample Rate 
Conversion 

    

Tracks 1-2 OFF    
Tracks 3-4 OFF    
     

TIMECODE SOURCE MANUAL    
Start: 00:00:00:00    

Table 1:  Channel 1 Factory Default Settings 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



 

  System Configuration = 83 

 
Figure 27: Channel 1 Input Configuration Dialog Window 

Input Source 
Select either CVBS (composite analog), or SDI (serial digital) for the input source. 

Track Arming 
The Image Server records video, audio and closed caption information as separate files that 
comprise a clip.  Video is always recorded; select the additional sources you wish to record. 

For certain video material such as keys or wallpaper no audio is needed.  For analog audio 
recording, a choice of zero or two audio channels is available.  With digital audio, a choice of 
zero, two, or four channels may be made.  Since the Image Server records 24-bit uncompressed 
PCM, a worthwhile savings of disk-space can be achieved by turning off audio tracks when not 
needed. 

Audio Sample Rate Conversion 
The Image Server always records audio at 48 kHz.  Select Sample Rate Conversion to convert 
off-speed digital audio sources to the Image Server’s 48 kHz internal clock rate. 
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Use Sample Rate Conversion with any 48K signal that is not referenced to either the same 
source as genlock, or the digital outputs of the Image Server. 

Bit-for-Bit® Recording & Playback 
The recording, storage, and playback of audio program material such as Dolby®-E, Dolby 
Digital (AC-3), or DTS® requires that upon playout the data stream be identical to the original.  
Do not use the audio sample rate converters when working with these encoded audio formats.  

The Image Server and a Dolby encoder must be supplied with the same genlock signal. 

Audio Sync Reference 
The audio sample rate is derived from the selected video sync reference.  Audio is recorded at a 
nominal 48K sample rate, so the 0.1% pull-down for 29.97 NTSC is taken into account when 
generating the audio sample rate for color NTSC.  There is no drop frame issue for PAL servers. 

Time Code Source 
This function selects the time code source for newly recorded clips.  A time code value is 
obtained from the selected input source at the start of a new recording.  Choose VITC, LTC, or 
Manual input source.  For manual, enter the desired time value for the first frame of the 
recording in the Starting Time Code entry field. 

The selected time code source value can be viewed in the Channel 1 CVBS Time Code burn-in 
window when E-E mode is monitoring the input source and no clip is cued.  When recording 
begins, E -E mode switches the monitor from the input to the disk and the Time Code burn-in 
window shows the current time code position. 

MPEG-2 Profiles 
Select either Main Profile @ Main Level (4:2:0), or 4:2:2 Profile @ Main Level for the 
recording. 

GOP Structure 
GOP structure defines the MPEG Group of Pictures coding as combinations of I, P, and B 
frames.  The allowable combinations are presented in a drop-down list.  I-Frame only encoding 
will produce the least compressed picture and requires the most hard disk space.  However, I-
frame encoding facilitates frame-accurate editing.  For broadcast-quality resolution, I-frame 
encoding should be considered at 20 or 25 Mb/sec.  When frame-accurate edits are required 
for production work, an I-frame GOP structure should be selected.  Very low bit rates should 
never be employed with I-frame encoding. 

Long-GOP video recorded with P and B frames produces superior image quality for a given 
data rate, compared to I-frame.  Most broadcasters go to air with 10 or 12 Mb content, having 
medium-length GOPs. 

Encode Mode 
Image Servers employ Variable Bit Rate  (VBR) MPEG-2 encoding.  For almost all broadcast 
applications, VBR encoding produces superior results than its alternative, Constant Bit Rate. 
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Maximum Bit Rates 
The range of available bit rates depends upon the MPEG-2 profile selected.  In Main Profile @ 
Main Level, the record bit rate ranges from 2 Mb/s to 15 Mb/s.  When the 4:2:2 Profile is 
selected, the range extends from 2Mb/s to 50 Mb/s. 

Output Configuration 
Select a channel from the dropdown menu.  For Channel 1, select the Output tab. 

To accept changes made to the configuration dialog box, click Apply.  Click OK to accept 
changes and close the configuration dialog window.  Click Cancel to close the window and 
discard any changes.  Changes to the Time Code Burn-in position are effective immediately.  
Changes to the Audio Slip will be effective when the clip is reloaded. 

 

Figure 28: Channel Output Configuration Window 

Time Code Burn-In 
This area of the dialog window sets the Time Code Burn-In ON or OFF.  When it is set ON, 
choose the display position on the video monitor from the drop-down list. 

SC/H Phase 
Adjusts the Sub-Carrier/Horizontal phase relationship.  Use a vector scope to view the phase 
relationship and adjust the setting.  Changes to the setting are effective immediately without 
clicking Apply or OK.  The adjustment range is ±90°. 
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Audio Slip 
Audio timing relative to picture output can be configured for audio channels 1-2  
and 3-4.  The value is set in millisecond (ms) increments, ±1,000ms.  The setting is applied 
to a clip when it is loaded for playback.
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Hard Disk Management 
 

This Image Servers employ an advanced Serial-ATA controller that manages four high-
capacity hard disks operating in a RAID-5 configuration.  This design increases system 
performance, and by storing parity data, helps prevent data loss should a drive fail. 

The Image Server brings a high level of reliability to Serial-ATA RAID through a new, 
switched architecture that exceeds the reliability of SCSI shared-bus storage systems.  The earlier 
shared-bus architecture of SCSI has inherent performance limitations due to arbitration latency, 
since only one drive may use the bus at a time.  Further, a single drive failure can bring the entire 
storage system down. 

By contrast, the Image Server uses a non-blocking switched architecture to isolate the drives 
from one another.  Any drive failure makes that drive unavailable and the rest of the storage system 
remains undisturbed.  In addition, the Image Server uses Advanced Data Protection features, where 
all drive commands are checked to ensure that no command corruption has taken place over the 
entire data path. 

Some of the Image Server RAID implementation features and benefits include: 

• Non-blocking switch technology with RAID 5 parity 
• On-board processor minimizes host CPU overhead 
• Easy-to-configure arrays  
• Dynamic sector repair for robust data protection 
• Accelerated RAID-5 writes 

About RAID 5 
A RAID 5 configuration features the data striping of RAID 0 combined with the parity benefits of 
RAID 4.  Using a simple parity (exclusive OR) function, RAID 5 can tolerate the loss of one drive.  
Parity information is distributed across all drives rather than being concentrated on a single disk.  
This avoids throughput loss due to contention for the parity drive.  Spare drives can be used to 
rebuild a failed array. 

RAID-5 capacity equals the size of drive times (number of drives -1).  In addition, the array’s 
storage efficiency increases with the number of disks; from 66.7 % for 3 drives to 75 % for 4 
drives: storage efficiency = (number of drives -1) X (number of drives). 
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Figure 29: RAID 5 Array Schematic 

Improved Write Performance 
The Image Server uses new designs to improve RAID-5 write performance for both large 
sequential and small random transactions.  This advanced block caching firmware delivers 
extremely high performance for RAID-5 write operations. 

Managing Disk Arrays 
The Image Server’s Disk Array Configuration Utility provides tools for monitoring and 
managing the disk array.  Monitoring and troubleshooting programs automatically check the 
array, report problems, and provide access to RAID status information and service options.  

A single drive fault should not cause data loss, but the drive array is degraded and no longer 
has storage redundancy.  Hence, another disk failure may cause a complete loss of data and 
system failure.  After a drive failure it is strongly recommended that at the earliest time 
diagnostics be performed, and the server be taken off line while the RAID array is rebuilt. 

Error Notification and Repair 
The Image Server will notify users in the event of a fault by flashing the front panel DRIVES 
light.  A flashing DRIVES light can be trigged by a variety of conditions.  The first step in 
response to a flashing light is to open the RAID CHECK STATUS window from the On-Screen 
Start Menu.  Click Start > RAID Status to launch the Array Configuration Utility.   
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The RAID CHECK STATUS window (Figure 22) displays the current status of the RAID 
controller and all disks connected to the RAID system.  On inspection, you will find the array 
in one of the following states: 

• OK, indicated by "OK" for Array Unit 0 and all Ports (drives); 

• Initializing , indicated by "Initializing" on the Array Unit 0 status line; 

• Degraded, indicated by "Degraded" on the Array Unit 0 status line; 

• Rebuilding, indicated by "Rebuilding x%" on the Array Unit 0 status line. 
 

Initializing is the way that the array controller corrects data parity errors that may have occurred 
because of power loss, incorrect shutdown, or some other data error.  Upon detection of a 
parity error, the controller will automatically start the initialization process as a background 
task.  This task should not interfere with Image Server’s ability to record or play clips. 

Parity errors may occur if the Image Server loses power, or is improperly shut off.  No data will 
be lost, but the parity reinitialization process may take several hours.  NEVER use the rear panel 
power supply switch to shutdown the Image Server.  Shutdown the system only by 
momentarily pressing the front panel power button or selecting Start > Shutdown > 
Shutdown from the graphic user interface. 

A degraded array with a drive listed as “Not In Service” or “Inaccessible” is usually indicative of 
a permanent drive error, typically a single disk or cable failure, but redundant data will allow 
normal operations to continue.  You may first try to rebuild the array with the existing drive still 
installed.  If the array continues to indicate a failed drive, replace the drive and then rebuild the 
array.  A hard disk array must be repaired using exactly the same drive model and capacity as 
other drives in the array.  Because specific drive model become unavailable as time goes on, 
360 Systems recommends that maintenance spares be  purchased at the same time as the Image 
Server.   
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Log-In to the RAID Utilities 

 
Figure 30: Log-In to RAID Utilities 

 

To log in to the RAID utilities, perform the following steps.  The above window will appear. 

• Open the RAID utilities by selecting START>SYSTEM>RAID STATUS 

• A Security Alert window will pop up and provide information about a security certificate.  
Select Yes to proceed. 

• In the Login window, select ADMINISTRATOR from the drop down menu.  

• In the Password window, make no entry. (leave it blank) 

• Click the Login Button to enter the Login Utilities. 

• The Summary screen will be displayed.  A message under the Status heading may appear.  
This can be either a WARNING or an ERROR, depending upon the severity of the problem. 
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 Displaying the Summary Window of the Raid Array 

 

Figure 31: Checking Status of RAID Array  Through the Summary Window 
 

The RAID controller keeps track of any condition that would adversely affect its reliability.  In 
the event that an error should occur, the Summary Window  will be helpful in diagnosing the 
problem.   

The above drawing will appear. 

• Make note of any error conditions reported. 

• Select MANAGEMENT>MAINTENANCE  from the screen. 

• The following screen will provide detailed information about the array status. 
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Determining the Condition of The RAID Array 

 
Figure 32: Report of RAID Array Condition 

 

To replace a failed drive in the RAID control utility, perform the following steps.   

• Select the [Remove Drive] option next to the DEGRADED drive. 

• The DEGRADED message next to the drive will change to NOT PRESENT. 

• If you suspect the drive is damaged, or if a previous Rebuild attempt has failed: 

1. Power down the system. 

2. Replace the failed drive with a drive of identical storage space.  Detailed information 
about how to replace hard drives is on page 110. 

3. Restart the system. 

4. Repeat the steps described earlier in this chapter – up to this point – then continue…  

• Click on the Rescan Controller button to identify available drives.  The following window 
will appear: 
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Rebuilding a RAID Array 

 

Figure 33: Rebuilding a RAID Array 
 

To rebuild the RAID drive array, perform the following steps: 

• Select the Unit 0 and Port 2 checkboxes. 

• Select Rebuild Unit.  A pop up window will ask for confirmation.  Re-select the  Port 2 
checkbox in the pop up window, then hit OK to begin re-building the array. 

• The rebuild process will begin. 
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The Maintenance Window – Rebuild Progress 

 

Figure 34: The Maintenance Window Shows Rebuild Progress 
 

The Maintenance window above will appear. 

• Rebuild progress is tracked in top of the drive status column (REBUILDING 17% in this 
example). 

• The rebuild progress will automatically update every 5 minutes.  Click the refresh button on 
your browser window for an immediate update.  

• When complete, 100% will be shown on the MAINTENANCE menu.  

 

Replacing Hard Drives 
The Image Server hard disk drives have been factory tested and configured into a RAID 5 array.  
Each drive is numbered (0-3) and must be attached to the matching numbered data cable.  Drive 
bays are also numbered. 
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Please read Removing the Front Panel on page 103 for instructions on accessing the hard drive 
bays.  Detailed information about how to replace hard drives is on page 110.
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Network File Transfers 
 

Apart from recording and playing program content through composite video and SDI 
connections, the Image Server can also act as an FTP server, delivering program material across the 
room or across the country.  Its Gigabit Ethernet port is standard equipment, and provides reliable 
high-speed transfers at much lower cost than Fibre Channel. 

The actual network transfer rate  depends on the number of video streams also being 
played, and their bit rate.  To ensure that video recording and playback can always take place, the 
Image Server gives network transfers a lower priority than video.  In practice, broadcast content 
encoded at 12 Mb/sec should transfer at a 5X rate, even while the server is playing video. 

MXF File Transfers  
The Image Server supports FTP-based import and export of files in MXF format.  The applicable 
standards are SMPTE 377M, 378M and SMPTE 381M.  Operational Patterns 1a and 1b files are 
supported. 

Network Operations 
FTP transfers to and from the Image Server are managed from an FTP client file transfer manager 
program running on a Windows® or Macintosh® computer.  This approach provides a rapid way to 
execute drag -and-drop file transfers; it can also manage many  Image Servers at once and does not 
tie up the Image Server GUI, which may already be in use.  Third party FTP manager programs are 
readily available for download through the Internet. 

FTP programs may also be used to move recorded or edited material between an Image Server and 
network attached storage (NAS) or a DVD-ROM library. 

Using the Image Server in a Large Network 
From a networking or system integration viewpoint, the Image Server appears as a normal drive 
to an FTP server in any size network, with the exception that it may only send, receive, or store 
video files that are compatible with the Image Server. 

Transfer of Edited Segments 
The Image Server sets MARK-IN and MARK-OUT points in a clip as “edit pointers.”  For all edit 
operations within a given Image Server, these pointers produce “virtual edits” that save disk 
space, and the time it would take to re-write the marked region as a new file. 

It is clearly impractical to transfer a long file to obtain a 30-second virtual clip marked within it.  
Therefore, the Image Server transfers only the region between In/Out points, and not the entire 
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file.  If you want to transfer the entire recording, be sure that the In/Out markers are set to the 
beginning and end of material before the transfer. 

To maintain the identity of the transferred clip, the time code references for its Mark-In/Out 
points are maintained, as shown in Figure 35:  Result of a network file transfer. 

 

 

Figure 35:  Result of a network file transfer 

File Sizes Reported in Listing 
The size of a clip reported in the file listing is the amount of video and audio data included 
between the In/Out points. 

Overwriting Files 
It is the responsibility of the client application (Windows Explorer, FlashFXP, etc) to ask the 
user if they want to overwrite a file. 

Interrupted and Resumed Transfers 
If a transfer is interrupted (for example, by a dropped connection) the amount of the file that 
has been transferred is kept on the target system.  Resumption of a partial transfer is planned for 
a future software release. 

System Security 
The Image Server can share program content on a network with other equipment to.  It appears 
as an anonymous FTP server, and is accessible to anyone on the network.  As with all servers, it 
is essential to use it behind a properly configured firewall. 

00:00:00;00 01:22:18;04 

00:30:00;00   
(IN POINT) 

00:32:00;00 
(OUT POINT) 

CLIP_A.mxf   

Before Transfer (On Source Image Server)   

00:30:00;00 00:32:00;00 

CLIP_A.mxf 

After Transfer (On Target Image Server) 
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FTP File Transfers 
For standard FTP transfers, the Image Server will recognize the following file formats: 

TARGA (.tga) 
During transfer, the Image Server will split the TARGA file into a Fill frame and a Key (Alpha) 
frame.  These two frames will each be converted to MXF MPEG-2 files, one frame in length.   

DV Stream (.dv) 
These are ‘elementary’ DV files containing a single stream of multiplexed audio and video.  
The Image Server will recognize and maintain .dv extensions on DV stream files, allowing 
transfer of .dv files between Image Servers and graphics workstations without modification.   

MPEG-2 (.mp2, mpg, mpeg, m2v) 
The Image Server will ingest valid MPEG-2 program or elementary streams.  The server’s ingest 
application will recognize a program stream that encapsulates a single MPEG-2 video stream, 
and up to 2 stereo pairs of 16- or 24-bit, 48kHz, uncompressed audio.  

MXF - Material Exchange Format (.mxf) 
Transfer of MXF files between compatible products is the preferred method of file interchange 
to-and-from an Image Server.  The server supports ingest and playout of MPEG-2 files based on 
SMPTE 377M, 378M and SMPTE 381M, Operational Patterns 1a and 1b. 

AVI Files (.avi) 
An AVI file is a container that encapsulates and describes a type of interleaved audio and 
video.  The Image Server will import Type 1 .avi files (a single stream of multiplexed audio and 
video) containing DV format video and 48K uncompressed audio.  During ingest of .avi files, 
the server will convert the file into a DV stream (.dv) for storage and future transfer. 
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Gigabit Ethernet Hardware 
A Gigabit Ethernet (RJ-45) connector labeled NET-1 is located on the rear panel for conventional 
network access. No hardware settings are available or needed, as Gigabit Ethernet automatically 
negotiates port speed.  Connection speed is shown by LEDs on the network connector.  The NET-1 
port also automatically configures transmit and receive connections, and does not need a 
“crossover” cable when connecting directly from one server to another. 
 

 Label Indication Meaning 

Green on The port is connected to a valid link 
partner 

Green flashing Data activity 
ACT/LNK 

(Left) 
 Off No link 

Off 10 Mbps 
Yellow flashing 100 Mbps 

10=OFF 
100=YELLOW 
1000=GREEN 

(Right) Green 1000 Mbps 

 

Redundant Server Connection 
The Gigabit Ethernet port labeled NET-2 on the Image Server is for redundant (mirrored) 
operation of two Image Servers. It does not use FTP protocol, and no connection should be 
made from it to other equipment. 

Gigabit Ethernet Cable Quality 
The high data rates generated by Gigabit Ethernet require high-quality cable designed for this 
application.  Low-quality network cables can result in high error rates and lower transmission 
speed.  For Gigabit operation, standard “CAT 5” cable should not be used. 

New Category 5e (enhanced) cables ensure maximum transfer rates, and should be used as the 
minimum standard.  Category 6 cable is a more recent product, designed for applications 
where longer cable runs are required.  

Configuring Network Settings 
The Image Server provides a number of user settings that configure it for use as a practical network.  
These will be found on the GUI System Network tab shown below. 

The NET-1 Ethernet port on the Image Server has a unique IP Address.  In this way, each Image 
Server can be identified on the network.  It also means that there is only one IP Address for a given 
volume of data. 
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Figure 36: Network Configuration Tab 

Network Settings Tab 
Use the Image Server graphic user interface to configure network communication settings. 

From the Main Menu selection bar at the top of the screen, select 
CONFIGURE>SYSTEM>NETWORK. 

Each Image Server is shipped with a unique default network Host Name and IP Address.  
Qualified network engineers may change these configurations to suit your specific network 
environment.  Factory defaults for networking are: 

• Network enabled 

• Use DHCP 
• Use automatic DNS 

Disable Networking Checkbox 
This selection turns the network OFF or ON.  The default is ON, but can be turned off to 
deny access to/from the network for security purposes. 
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Use DHCP Checkbox  
Enabling DHCP will configure the network interface automatically. 

If the DHCP box is not selected, the user may then manually enter assignments in the 
following windows: 

• Host Name 
• IP Address 
• Net Mask 
• Default Router 

Host Name may be a fully qualified domain name, such as edit1.mydomain.com.  All other 
manually configured addresses must be properly formatted IP addresses. 

Manual DNS Checkbox 
When using DHCP, the DNS name resolution is usually configured automatically.  Enabling 
Manual DNS configuration requires that a DNS server address be supplied for name 
resolution. 

Saving Network Configuration 
Click on OK, APPLY, or CANCEL to accept or abandon new entries. Changes will not take 
effect until the Image Server is powered off and on. 
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Maintenance 

Fault Diagnostics 

Front Panel Indicators 
The five LED indicators on the front panel are used to diagnose server fault conditions.  The 
meaning of each indicator is noted in the following table.  During normal operation, all five 
indicators will be on. 
 

GENLOCK OFF indicates that the Genlock setting 
in the System menu is “Internal” 
FLASHING indicates that Genlock is 
selected in the System menu, but 
there is no signal, or an invalid signal, 
at the GENLOCK input connector. 

Check the Genlock setting in the On-
Screen System menu. 
Check the Genlock cable connections 
or signal. 

POWER FLASHING indicates that there is a 
fault in the system power supply. 

Shut down the Image Server and 
contact 360 Systems Customer Support 
for further hardware diagnosis. 

FANS FLASHING indicates that there is a 
fault of the internal chassis fan. 

Check the chassis fan operation.  
Replace if necessary.  Do not run the 
Image Server without a working fan. 

DRIVES FLASHING indicates that there is a 
fault in the system RAID array. 

Check the RAID array status using 
the utility under 
START > RAID STATUS. 

SYSTEM FLASHING indicates that the CPU fan 
is running slow, or stopped; or that the 
CPU temperature or voltage is not 
within manufacturer’s specification. 

Shut down the Image Server and 
contact 360 Systems Customer Support 
for further hardware diagnosis. 

 

 

Repairs should be performed only by qualified electronics 
technicians. 
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Gigabit Ethernet Indicators 
 
The Gigabit Server Adapter card has the following indicator lights: 

 Label Indication Meaning 

Green on The port is connected to a valid link 
partner 

Green flashing Data activity 

ACT/LNK 
(Left) 

 Off No link 
Off 10 Mbps 

Yellow flashing 100 Mbps 
10=OFF 

100=YELLOW 
1000=GREEN 

(Right) Green 1000 Mbps 

 

Access to Components 

 

Be certain to shut down the Image Server, turn off the rear panel power 
switch and disconnect the power cord before opening the unit for service. 

 

The following sections provide instruction on disassembly and re-assembly for maintenance. 

The front panel is removed to access the internal CD-ROM drive (for system program updates), or 
to service the hard drives. 

The top cover is removed to access the analog/digital audio selection jumpers, or to service an I/O 
card, the system board, or power supply. 

Removing the Front Panel 
The front panel is easily removed for access to the CD-ROM drive, the four disk drives, or for 
removing the server from an equipment rack.  Using a coin or a flat-blade screwdriver, unscrew 
the two large panel fasteners on the left and right sides of the face panel.  Hold the panel in 
place while undoing the screws.  Since the loosened screws are captive, you may use them to 
pull the panel away from the chassis. 

To re-install the front panel, tuck all wires into the chassis and move the face panel into 
position.  Screw the front panel fasteners back into the chassis.  Tighten the front panel access 
screws with a screwdriver. 

Removing the Top Cover 
Using a No. 2 Philips head screwdriver, unscrew the three 6-32 Philips head screws attaching 
the top cover to the rear panel.  Slide the cover back until it is clear of the front panel, and then 
lift it off. 
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To re-install the top cover, set the cover on top of the chassis and slide the cover forward until 
its front pins engage the front panel.  Secure the cover to the rear of the chassis with the three 
6-32 screws. 

General Handling Precautions 

ESD Precautions 

 

Observe electrostatic discharge (ESD) precautions to avoid 
damaging static-sensitive components when handling any 
PC card or disk drive. 

 
When the case of your server is open and its internal parts are exposed, do not touch 

any internal part without first grounding yourself to the chassis. 
Always wear a ground strap or work on an ESD-protective mat. 
DO NOT remove components from protective packaging until you are properly 

grounded. 
Handle printed circuit boards by their edges or by the metal bracket. 
Don’t touch any pin, contact, lead or component on the printed circuit boards. 
Keep disk drives in their anti-static package until installed in the server. 

Mechanical Concerns 
Be careful when installing I/O cards into your system.  Excessive force can damage the 

PC boards, cables, hard drives or the motherboard. 
Be sure each board is aligned with its slot in the mating connector before installing.  Use 

care to not flex any PC boards. 
Interface cable connectors must be mated carefully. Use care to not bend any of the 

pins.  The connectors provided are keyed to prevent upside-down insertion. 
Interface cables are fragile and must not be pinched. Ensure that their dress does not 

restrict airflow from fans or heat sinks within the enclosure. 
Prior to installation, keep disk drives stored in a foam-lined protective carton to protect 

them from physical damage. 
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Installing/Removing I/O Cards 
Follow the preceding instructions to remove the top cover.  The I/O cards are accessible from 
the top of the chassis.  Generally, I/O cards can be extracted or installed with a No. 2 Philips 
screwdriver.  Each I/O card is held in place by one or two 6-32 X ¼” pan head Phillips screws 
on the rear panel of the chassis. 

Low Profile PCI Cards 
Remove the 6-32 x ¼” pan head Phillips screw holding the I/O card to the rear panel.  Pull 
the I/O card from its slot.  Reverse the procedure to install a card. 

Video I/O Card 
Remove the 6-32 x ¼” pan head Phillips screw holding the video card to the rear panel.  
The video I/O card is also held by a support bracket near the front panel.  Remove the 6-32 x 
¼” pan head Phillips screw holding the bracket to the inside wall of the chassis. 

While supporting the riser card, gently pull the video card from the riser card.  When the 
video card is clear of the PCI riser connector, move the card toward the front of the Image 
Server until the video connectors are clear of the rear panel.  Lift the video card from the 
chassis.  Unplug the 50-pin ribbon cable from the video card.  Immediately place the video 
card into a conductive storage bag to protect it from electrostatic discharges. 

Reverse the procedure to install a card.  After all the screws are reinstalled, check that the 
riser card, RAID card, and video card are all seated properly in their PCI connectors. 

RAID Controller Card 
Unplug the four Serial-ATA cables from the RAID card.   

Remove the 6-32 x ¼” pan head Phillips screw holding the RAID card to the rear panel.  
Gently pull the card from its slot. Immediately place it in a conductive storage bag for 
protection from electrostatic discharge that can damage it. 

Reverse the procedure to install a card.  Be certain to install the Serial ATA cables into the 
correct RAID card connectors.  The cables are marked with connector numbers to match the 
numbers appearing next to each RAID card connector.  If these cables are not connected 
correctly, the data in the RAID array will be destroyed. 

Accessing the Motherboard 
There are no user-configurable options to set on the main system board.  If you suspect that the 
system board is not operating properly, consult with 360 Systems before proceeding.  DO NOT 
undertake any repairs on the motherboard. 
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Audio Level Calibration 
The input gain and output gain of the analog audio circuits are factory calibrated to a +4 dBu 
standard.  Each circuit includes a trim pot with a range of approximately ±2.5 dB.  The following 
procedures may be used to calibrate these for unity gain.  Each trim pot is located above the XLR 
connector with which it is associated.  Refer to the preceding drawing (Figure 27) for the location 
of trim pots and jumper blocks referred to in the calibration procedures. 

Calibration Procedure 
This procedure assumes that the technician is fully familiar with test procedures employing the 
Audio Precision® test equipment, or its equivalent. 

1. Position the jumper block J5 and J6 for Channel 1 output to obtain an analog output. 

2. Play the test clip titled zTONE present on the Image Server disk.  This stereo clip is 
recorded at a level equivalent to a +4 dBu output level. 

3. While observing the output level of audio Channel 1 Left, adjust trimmer RV4 until a level 
of exactly +4.00 dBu is obtained. 

4. Repeat this procedure for audio Channel 1 Right, while adjusting trimmer RV3, and also for 
each subsequent audio channel using its associated trim pot. 

Having established accurate gain settings for all analog audio outputs in steps 1 through 3 
above, calibrate the Image Server’s input gain as follows: 

5. Using the graphic user interface, place server Channel 1 in the E-E mode, so that an input 
signal will appear at its output. 

6. While observing the output level of audio Channel 1-L, apply a 1 kHz sine wave from the 
audio generator to audio Input 1-L.* 

7. Adjust input trimmer RV2 until a level of exactly +4.00 dBu is obtained at the output of 
Channel 1L. 

8. Repeat this procedure for audio Input 1-R, making the gain adjustment with input trimmer 
RV1. 

The preceding steps establish a gain of unity through the server. 

* In the absence of a generator, use the calibrated outputs of Channel 2 playing zTONE to 
feed the inputs. 
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Alternate Calibration Procedure 
If the calibration test clip titled z1K_TONE is not found on the Image Server’s disk, it is still 
possible to accurately calibrate the audio channels. 

1. Position the jumper block J5 and J6 for Channel 1 output to obtain a digital output. 

2. Using the On-Screen graphic user interface, place server Channel 1 in the E-E 
mode, so that an input signal will appear at its output. 

3. Use the audio generator to apply a 1 kHz sine wave at a level of +4 dBu to analog 
audio Input 1-L. 

4. While observing the digital output level of audio Channel 1-L, adjust input gain trim 
pot RV2 until a level of –20 dBFs is obtained. (+4 dBu is 20 dB below full scale, 
which is +24 dBu; therefore it reads 20 dB below full scale or Fs.) 

5. Repeat steps 2 through 4 for analog audio Input 1-R, while adjusting input gain trim 
pot RV1. 

The server’s input gain is now calibrated.  It remains to calibrate each analog output for unity 
gain using the following procedure: 

6. Position all audio output jumper blocks to obtain analog outputs. 

7. Using the graphic user interface, verify that server Channel 1 is in E-E mode, so that 
an input signal will appear at its output. 

8. Apply a 1 kHz sine wave at a level of +4 dBu to analog audio Input 1-L. 

9. While observing the output level of audio Channel 1-L, adjust output gain trim pot 
RV4 until a level of +4 dBu is obtained. 

10. While observing the output level of audio Channel 1-R, adjust output gain trim pot 
RV3 until a level of +4 dBu is obtained. 

11. Make a 1-minute clip of the 1 kHz sine wave at a level of +4.00 dBu. Save this clip 
for future use in calibrating the server. 

12. Play this clip from Channel 2 and repeat steps 9 and 10 to adjust the gain of the left 
and right outputs. 

13. Play the clip created in step 11 from Channel 3 and repeat steps 9 and 10 to adjust 
the gain of the left and right outputs. 

The server’s output gains are now calibrated, and the entire sequence of the preceding steps 
have established a gain of unity through the server. 

Another method is to use digital input with a digital sine wave of –20dBFS to calibrate analog 
outputs 1 & 2 and create the reference clip. 
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Program Updates via CD-ROM 
The Image Server operating system and On-Screen User Interface programs can be updated by the 
user via the internal CD-ROM drive.  Program updates will be made available by 360 Systems from 
time to time.  The current software version may be determined by looking in the On-Screen 
program About box, or by pressing the F1 key. 

To install a program update, follow these instructions.  Please read them completely before 
beginning. 

1. Remove the Image Server front panel.  The internal CD-ROM drive will be seen at the 
left front of the server. 

2. With the Image Server powered on, press the CD eject button on the drive.  The drawer 
will open a short distance.  Gently pull the drawer open and insert the CD-ROM disk, 
printed side up.  Push the drawer closed until it latches. 

3. Press the front panel power switch briefly to shutdown the Image Server. 

4. Wait 5 seconds, then press the front panel power switch again to boot from the CD. 

5. The Installer menu provides a choice to Update the Image Server operating system, 
begin a new complete install, or cancel the install. 

• Choose UPDATE if you want to keep the video and audio clip files that exist on 
the Image Server.  Use this selection for all normal software updates. 

• Choose NEW only if you want to partition and reformat the drive array, and 
install the new operating system. 
 
IMPORTANT! Using the NEW option will destroy all video and audio files on 
the Image Server.  For normal software upgrades, use the UPDATE option 
instead of NEW. 

6. The message, “Please wait while Image Server is being installed” will appear with an 
activity indicator.  When installation is complete, the server will automatically reboot 
from its hard disk array, and display the usual copyright notice while it is starting up. It 
will also release the CD drawer. Remove the CD.  Never leave it in the CD drive. 

7. Replace the front panel.  Tighten the two large front panel access screws. 

If a disk cannot be ejected because the system is not responding or is powered off, the CD-ROM 
drawer can be released by inserting a paper clip into the small hole on the front of the drive. 
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Replacing a Hard Drive 
Generally, the only time that a hard drive should be removed from the disk array is when the drive 
array diagnostic software identifies a permanent fault.  In this case, the front panel DRIVES LED will 
blink.  Use the hard disk management tools to verify that a drive is at fault.  The application 
monitors many things about the array and individual drives, and will clearly indicate whether a 
drive has failed. 

Each hard drive bay is numbered 0 through 3, as are the drives.  If for any reason one or more 
drives have been removed, they must be reinstalled in a bay whose number matches the drive.  
Installation in the wrong location will damage data stored on all drives. 

1. Turn system power OFF with the front panel button.  After it has shut down, turn off the AC 
power switch and unplug the AC power cord. 

2. Remove the front panel as described above. 

3. Unscrew the holding plate from the front of the drive sub-chassis. 

4. Disconnect the power and Serial ATA data cable from the drive, and remove it from the 
drive bay. 

5. Replace the drive, fasten the holding plate in place, and reattach drive cables.  Note that 
the data cables are numbered; re-attach then to the same drive location from which they 
were removed. 

6. Replace the front panel and tighten the two large screws. 

7. Replace the AC power cord and turn on the rear panel AC switch. 

8. Turn the system ON using the front panel button and check the RAID array status. 

9. Check for correct operation of the server. 

NOTE: All drives in the RAID array must be identical. 

Factory Repair Policy  
A video server being returned under warranty shall be sent to 360 Systems, freight prepaid, in the 
original or equivalent packaging.  Call 360 Systems for a return authorization number before 
returning a product. 

Use the following address for shipping and correspondence.  360 Systems’ offices are open 
Monday through Friday, from 8:30 AM to 5:00 PM, Pacific Time. 

 
360 Systems  Telephone (818) 991-0360 
Customer Service Dept. Fax (818) 991-1360 
31355 Agoura Road E-mail info@360systems.com 
Westlake Village, CA  91361 Website  www.360systems.com 
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Regulatory Certifications 

Safety 
The Image Server was tested by Underwriters Laboratories and found to comply with the 
following safety standards: 

EN 60950, 3rd Edition, dated December 1, 2000, Standard for Safety of Information 
Technology Equipment, Including Electrical Business Equipment. 

Laser Compliance 
The CD-ROM device used in this product is a Class 1 certified laser product.  Operating this 
product outside specifications or altering its original design may result in hazardous radiation 
exposure, and may be considered an act of modifying or new manufacturing of a laser 
product under U.S. regulations contained in 21 CFR Chapter 1, subchapter J or CENELEC 
regulations in HD 482 S1.  People performing such an act are required by law to re-certify 
and re-identify this product in accordance with provisions of 21 CFR subchapter J or 
distribution within the USA, and in accordance with CENELEC HD 482 S1 for distribution 
within countries using the IEC 825 standard. 

Laser Safety 
Laser safety in the United States is regulated by the Center for Devices and Radiological 
Health (CDRH).  The laser safety regulations are published in the “Laser Product 
Performance Standard,” Code of Federal Regulation (CFR), Title 21, Subchapter J. 

The International Electrotechnical Commission (IEC) Standard 825, “Radiation of Laser 
Products, Equipment Classification, Requirements and User’s Guide,” governs laser products 
outside the United States.  Europe and member nations of the European Free Trade 
Association fall under the jurisdiction of the Comité Européen de Normalization 
Electrotechnique (CENELEC). 

Radio Interference Compliance 

Radio Interference (USA) 
WARNING: This equipment has been tested and found to comply with the limits for Class A 
digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment.  This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction's manual, may cause 
interference to radio communications.  Operation of this equipment in a residential area is 
likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

The user is cautioned that changes and modifications made to the equipment without 
approval of the manufacturer could void the user's authority to operate this equipment. 
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It is suggested that the user use only shielded and grounded cables to ensure compliance 
with FCC Rules. 

FCC Emission Limits 
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesirable 
operation. 

Radio Interference (Canada) 
English: This Class A digital apparatus meets all requirements of the Canadian Interference -
Causing Equipment Regulations. 

Français: Cet appariel numérique de la classe A respecte toute les exigences du Reglement 
sur le matériel brouilleur du Canada 
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Product Warranty and 
End-User License Agreement 

Limited Warranty  
This product is warranted to the original purchaser against defects in material and workmanship for 
a period of one year from the date of original purchase.  This warranty covers parts and labor and is 
effective when the product is used without alteration for the purpose intended by 360 Systems.  
This warranty excludes products with modified or unauthorized software, that have been subject to 
misuse or neglect, that have been modified, repaired improperly or by unauthorized personnel, 
damaged by rough handling, abuse, improper operation, excessive temperature, lightning strike, 
static electricity, electrical surges or other electrical system malfunctions, improper or inadequate 
maintenance or care and that have been subject to use of unauthorized or non-conforming 
accessories or attachments.  This warranty also excludes normal wear and deterioration occasioned 
by the use of the product. 

If part of the product is defective, the entire product must be returned along with the original 
purchase receipt or other evidence of purchase and a description of the defect to 360 Systems, 
31355 Agoura Road, Westlake Village, California 91361.  Upon receipt, its condition will be 
verified, and if the product qualifies for warranty coverage, 360 Systems will, at its option, repair or 
replace the product without charge.  In the case of replacement, if the replacement for a defective 
product is no longer available, 360 Systems will replace it with a similar product or, if not 
available, a product of equal value. 

Disclaimer and Limitation of Liability 
The liability of 360 Systems under the foregoing warranty is limited solely to the repair or 
replacement of defective material or workmanship and does not include any expense related to the 
shipment of the product to or from 360 Systems or compensation for any inconvenience or loss of 
use of the product while it is being repaired or replaced. 

Except as expressly stated herein, 360 Systems makes no representations or warranties, either 
express or implied, of any kind with respect to the product.  EXCEPT AS EXPRESSLY STATED 
HEREIN, 360 SYSTEMS EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, OF 
ANY KIND WITH RESPECT TO THE PRODUCT, INCLUDING WITHOUT LIMITATION 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.   

360 SYSTEMS’ SOLE LIABILITY UNDER THIS LIMITED WARRANTY SHALL BE THE REPAIR OR 
REPLACEMENT OF ANY DEFECTIVE PRODUCT OR ITS COMPONENTS DURING THE 
WARRANTY PERIOD.  IN NO EVENT SHALL 360 SYSTEMS, ITS DIRECTORS, OFFICERS, 
EMPLOYEES OR REPRESENTATIVES BE LIABLE FOR DIRECT, CONSEQUENTIAL, PUNITIVE, 
SPECIAL OR INDIRECT DAMAGES, LOSS OF PROFITS, INCONVENIENCE OR ANY OTHER 
LOSSES DUE TO THE PRODUCT OR ITS OPERATION, DUE TO ITS FAILURE TO OPERATE IN 
ACCORDANCE WITH ITS SPECIFICATIONS. 
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Some states do not allow the exclusion or limitation of incidental or consequential damages under 
certain circumstances, so the above limitations and exclusions may not apply to you.  This 
warranty gives you specific legal rights, and you may also have other rights which vary from state 
to state. 
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End User License Agreement 

For Image Server Software 
 
IMPORTANT 
THIS IS A LEGAL AGREEMENT BETWEEN YOU (“YOU”) AND 360 SYSTEMS® (“COMPANY”).  
COMPANY IS WILLING TO LICENSE THE IMAGE SERVER  SOFTWARE TO YOU ONLY UPON 
THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS SOFTWARE 
LICENSE AGREEMENT (“AGREEMENT”).  PLEASE READ THE TERMS CAREFULLY BEFORE 
OPENING THIS PACKAGE, OR IF DOWNLOADED, BEFORE INSTALLING THE SOFTWARE, AS 
OPENING THE PACKAGE, OR IN THE CASE OF DOWNLOADED SOFTWARE, INSTALLING IT, 
WILL INDICATE YOUR ASSENT TO THEM.  IF YOU DO NOT AGREE TO THE LICENSE TERMS, 
THEN COMPANY IS UNWILLING TO LICENSE THE SOFTWARE TO YOU, IN WHICH EVENT 
YOU MAY RETURN THE UNOPENED SOFTWARE PACKAGE TO THE PLACE FROM WHICH IT 
WAS ACQUIRED WITHIN 14 DAYS OF THE DATE OF PURCHASE AND YOUR MONEY WILL 
BE REFUNDED.  IF YOU ARE VIEWING THIS AGREEMENT ELECTRONICALLY, SELECT THE 
“ACCEPT” BUTTON AT THE BOTTOM OF THIS PAGE TO INDICATE YOUR ACCEPTANCE OF 
THE TERMS OF THIS AGREEMENT.  IF YOU ARE NOT WILLING TO BE BOUND BY ITS TERMS, 
SELECT THE “DECLINE” BUTTON AT THE BOTTOM OF THIS PAGE AND THE REGISTRATION 
OR INSTALLATION PROCESS WILL NOT CONTINUE. 
 
1. Company grants to You a nonexclusive license to use the Image Server software program (the 

“Software”) and any accompanying documentation (“Documentation”) solely for your internal business 
needs pursuant the terms and conditions of this Agreement.  The license to use the Software is 
conditioned upon Your compliance with the terms of this Agreement.  You shall be solely responsible 
for installation of the Software. 
 
Your use of the Software is limited to the licensing option set forth on your invoice.  Each licensing 
option is defined as follows: 
 
Single User License.  Software provided to You under this option may only be installed on any Image 
Server owned or controlled by You, but in no event may it be used on more than one Image Server  at 
the same time. 
 
Multiple User License.  Software provided under this option may be installed on more than one Image 
Server owned or controlled by You, the maximum number of which is indicated on the purchase invoice 
for this Software. 
 

2. You may not transfer the Software to another entity or person.  Any such transfer terminates your license 
under this Agreement.  You shall not modify, translate, reverse assemble or reverse compile in whole or 
in part the Software that is provided in object code.  You may not rent, sell, time-share, lease, sublicense, 
transfer, publish, disclose, display, or otherwise make available the object code or copies thereof to 
others.  You may not make copies of the object code except as provided herein.  You shall not tamper 
with, bypass or alter any security features of the Software or attempt to do so. 
 

3. This license is not a sale.  Title, ownership rights, and intellectual property rights in and to the Software 
and Documentation shall remain with the Company.  You agree to abide by the copyright laws and all 
other applicable laws of the United States.  You acknowledge that the Software design remains a 
confidential trade secret of Company.  Failure to comply with the above restrictions will result in 
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automatic termination of this license and will make available to Company other legal remedies.  You 
may not disclose any of Company’s proprietary or trade secret information relating to the Software to any 
third party. 
 

4. Company warrants that the Software will perform substantially in accordance with its Documentation.  
Your exclusive remedy for breach of this limited warranty and Company’s entire liability shall be, in 
Company’s discretion, either return of the price paid to Company by You for the Software, or repair or 
replacement of the Software after Software and Documentation are returned to Company with an 
applicable receipt.  Company’s warranty is void if failure of the Software has resulted from accident, 
abuse, modification or misapplication.  COMPANY MAKES NO OTHER WARRANTIES, EXPRESS OR 
IMPLIED, WITH RESPECT TO THE SOFTWARE AND DOCUMENTATION, AND SPECIFICALLY 
DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  COMPANY DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR FREE. 
 

5. TO THE MAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT SHALL COMPANY BE LIABLE FOR 
ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES WHATSOEVER, 
INCLUDING ANY CLAIMS FOR LOST PROFITS, BUSINESS INTERRUPTION, LOST INFORMATION 
OR OTHER DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE.  IN ALL 
EVENTS, COMPANY’S SOLE OBLIGATION OR LIABILITY UNDER THIS LICENSE IS THE 
REPLACEMENT OR REPAIR OF THE SOFTWARE OR A REFUND OF THE PURCHASE PRICE. 
 

6. You may terminate the license granted in Section 1 of this Agreement at any time by destroying or 
erasing your copy of the Software.  Company may terminate this Agreement immediately and without 
notice if you fail to comply with any term or condition of this Agreement.  In the event of termination of 
this Agreement, all the sections of this Agreement will survive except for Section 1. 
 

7. This Agreement shall be governed by and construed in accordance with the laws of the State of 
California, U.S.A., without reference to conflicts of laws provisions or the 1980 U. N. Convention on 
Contracts for the International Sale of Goods and, as to matters affecting copyrights, trademarks and 
patents, by U.S. federal law.  Any dispute with respect to this Agreement shall be brought and heard 
either in the California state courts located in Los Angeles County, California, or the federal district court 
for the Central District, Western Division, located in Los Angeles, California.  In such event, the parties 
to this Agreement each consent to the in personam jurisdiction and venue of such courts.  The parties 
agree that service of process upon them in any such action may be made if delivered in person, by 
courier service, by telegram, by facsimile or by first class mail, and shall be deemed effectively given 
upon receipt. 
 

8. This Agreement sets forth the entire agreement between You and Company pertaining to the licensing of 
the Software, and supersedes in its entirety any and all written or oral agreements previously existing 
between the parties with respect to such subject matter.  If any provision of this Agreement is held 
invalid or unenforceable, such provision shall be revised to the extent necessary to cure the invalidity or 
unenforceability, and the remainder of this Agreement shall continue in full force and effect.  In the 
event of any conflict between any provision of this Agreement and applicable law, the provisions of this 
Agreement affected shall be modified to remove such conflict and permit compliance with such law, and 
as so modified this Agreement shall continue in full force and effect.  This Agreement may not be 
assigned without the consent of Company. 
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Appendix A 

Connector Specifications 
 

Audio XLR-3 Connector Pinout 
Signals appearing on the XLR connectors are determined by the setting of the internal 
Analog/Digital Audio Selection jumpers. 

 

Pin BALANCED ANALOG AES/EBU DIGITAL 

1 SHIELD (FRAME GROUND) SHIELD (FRAME GROUND) 
2 " + " OR HOT DIGITAL + 
3 " – " OR COMMON DIGITAL - 

SHELL FRAME GROUND FRAME GROUND 
  

Serial Control Connector Pinout 
 

Pin EIA-422, DB9-F 
Connector 

1 GND 
2 Transmit A (TX–) 
3 Receive B (RX+) 
4 GND 

5 N/C 
6 GND 
7 Transmit B (TX+) 
8 Receive A (RX-) 
9 GND 

Shell Frame ground 
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BNC Connectors 
The following note applies to all video, LTC, and Genlock connectors: 

• A BNC connector used as an output will have a 75-ohm source impedance. 

• A BNC connector used as an input will have a fixed 75-ohm termination. 

 

GPI Connector 
General purpose control inputs (GPI) may be applied to the GPI port, which is a DB-25-F 
connector.  These inputs are optically isolated from the Image Server circuitry; individual 
floating returns are provided.  +5 volts may be sourced from pins 21 or 22, or provided from 
an external source.  Current limiting devices are provided within the Image Server. 

General purpose status outputs also appear on the GPI connector.  Open-collector outputs are 
provided as status outputs, and may be used to drive an external LED or control input. 

Refer to the connector pin-out table and partial schematic, following. 

GPI Connector Pinout 
 

Pin Signal Pin Signal 

1 GPI 1 14 GPI 1 RTN 
2 GPI 2 15 GPI 2 RTN 

3 GPI 3 16 GPI 3 RTN 
4 GPI 4 17 GPI 4 RTN 
5 GPI 5 18 GPI 5 RTN 
6 GPI 6 19 GPI 6 RTN 
7 N/C 20 N/C 

8, 9, 10 GND 21, 22 +5V SOURCE (200MA MAX) 
11 GPO 2 23 GPO 1 
12 GPO 4 24 GPO 3 
13 GPO 6 25 GPO 5 
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1GPI 1

GPI 1 RTN

9SIGNAL GND

14

10

13GPO 6

25GPO 5

12GPO 4

24GPO 3

11GPO 2

22

INPUTS

OUTPUTS

+5V, 200mA MAX 
SOURCE

GPI/O (DB25-F)

1K

INTERNAL CIRCUITS

1K

15

2

3

16

1K

4

17

1K

5

18

1K

6

19

1K

GPO 1 23

GPI 2 RTN

GPI 2

GPI 3 RTN

GPI 3

GPI 4 RTN

GPI 4

GPI 5 RTN

GPI 5

GPI 6 RTN

GPI 6

21

8

 
Figure 38: GPI Connection Schematic 
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System Board Ports 
Standard computer I/O ports on the Image Server include video monitor, keyboard, mouse, and 
Gigabit Ethernet ports. Pinouts are provided to assist in wiring or trouble-shooting. 

Keyboard and Mouse 
Keyboard and mouse ports are provided on the rear panel.  Both ports are provided with a 
resetable fuse protecting the +5V supply to the peripheral. 

SVGA Ports  
A VESA-compliant VGA or SVGA computer monitor may be connected to the 15-pin video 
port.  The Image Server is pre-configured to an SVGA screen resolution of 1024 x 768 and 
64,000 colors.  The refresh rate will auto-negotiate with the attached monitor to achieve the 
best available value.  This resolution is best viewed on 17-inch or larger monitors.  Use only 
VESA compliant monitors.  360 Systems does not provide monitors for the server. 

SVGA Connector Pinout 

Pin Signal Pin Signal 
1 RED 9 +5V 

2 GREEN 10 GND 

3 BLUE 11 RESERVED* 

4 RESERVED* 12 SDA 

5 GND 13 HSYNC 

6 RED RTN 14 VSYNC 

7 GREEN RTN 15 SCL 

8 BLUE RTN SHELL FRAME GROUND 

      * Pulled high to +5V. 

Unused Ports  
USB ports and an RS-232 serial port are present on the Image Server.  These are not active 
and no connection should be made to them. 
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Appendix B 

Serial Command Protocols 

VDCP Command Table 
The Image Server responds to the following VDCP commands.  Shaded areas indicate 
commands slated for future implementation. 

COMMAND FROM CONTROLLER RETURN FROM CONTROLLED DISK 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

0X / 8X 15 Delete Protect ID  04 ACK 
0X / 8X 16 Undelete Protect ID  04 ACK 

 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

1X 00 Stop  04 ACK 
1X 01 Play  04 ACK 

1X 02 Record  04 ACK 

1X 04 Still  04 ACK 

1X 05 Step  04 ACK 
1X 06 Continue  04 ACK 

1X 07 Jog  04 ACK 
1X 08 Varispeed Play  04 ACK 

1X 0A EE Mode  04 ACK 
 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

2X / AX 1D Rename ID  04 ACK 
2X 1E Preset Std. Time  04 ACK 

2X / AX 1F New Copy  04 ACK 

2X  20 Sort Mode  04 ACK 

2X  21 Close Port  04 ACK 
2X  22 Select Port  04 ACK 

2X / AX 23 Record Initialize  04 ACK 
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2X / AX 24 Play Cue  04 ACK 
2X / AX 25 Cue with Data  04 ACK 

2X / AX 26 Delete ID  04 ACK 
2X / AX 2C Record Init with Data  04 ACK 

2X  30 Preset  04 ACK 
 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

3X  01 Open Port 3X 81 Grant/Denied 
3X / BX 02 Next 3X 82 List of ID's 

3X  05 Port Status Request 3X 85 State Status 
3X  06 Position Request 3X 86 Position 

3X / BX 07 Active ID Request 3X 87 Active ID 
3X  08 Device Type Req. 3X 88 Device Type 

3X  10 Syst. Status Request 3X 90 System Status 
3X / BX 11 ID List 3X 91 List of ID's 

3X / BX 14 ID Size Request 3X 94 ID Size 
3X / BX 16 ID Request 3X 96 ID Presence 

3X  17 Compression Settings 
Request 

3X 97 Compression Settings

3X / BX 18 ID's Added List 3X 98 List ID's Added 

3X / BX 19 ID's Deleted List 3X 99 List ID's Deleted 
 

AX and BX versions are long-filename variants, not yet implemented. 

Macro commands (5X/DX in CMD-1) are not implemented. 

The following commands are reserved to maintain manufacturer compatibility with existing 
systems: 0X.12, 2X.28, 2X.36, 2X.3B, 2X.3C, 2X.3D, 2X.3E, 2X.3F, 2X.43, 2X.44, 2X.45, 2X.70, 
2X.71, 2X.C2, 3X.20, 3X.21, 3X.22, 3X.23, 3X.24, 3X.60, 3X.78, 3X.79, 3X.7A, 3X.7B, 3X.7C, 
3X.7D, 3X.7E, 3X.7F, FX.XX (archive commands) 
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P2 Serial Command Table  
The Image Server command set includes most commands used in BVW tape machines. 
Commands not implemented include those for DMC operations, audio split and in/out points, 
and those specifically related to tape as a medium.  

The server will return Device Type response 20.25 for BVW-75 (NTSC); 21.25 for BVW-75 
(PAL). 

 
COMMAND DESCRIPTION RETURN COMMENT 

00.11 DEVICE TYPE REQUEST ACK  
00.1D LOCAL ENABLE ACK  

00.0C LOCAL DISABLE ACK  
20.00 STOP ACK  
20.01 PLAY  ACK  
20.02 RECORD ACK  
20.10 FAST FORWARD ACK  

2X.11 JOG FORWARD ACK  
2X.12 VAR FORWARD ACK  
2X.13 SHUTTLE FORWARD ACK  
20.20 REWIND ACK  
2X.21 JOG REVERSE ACK  
2X.22 VAR REVERSE  ACK  

2X.23 SHUTTLE REVERSE ACK  
20.30 PRE-ROLL ACK  
20.0F EJECT ACK  
20.05 STANDBY ON ACK  
20.60 FULL E-E OFF ACK   

20.61 FULL E-E ON ACK  
24.31 CUE UP WITH DATA ACK  
40.08 TIMER 1 RESET ACK  
40.10 IN ENTRY ACK  
40.11 OUT ENTRY ACK  

40.18 IN SHIFT + ACK  
40.19 IN SHIFT - ACK  
40.1A OUT SHIFT + ACK  
40.1B OUT SHIFT - ACK  
40.2D LOST LOCK RESET ACK   

41.36 TIMER MODE SELECT ACK  
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41.37 INPUT CHECK ACK  

44.00 TIMER 1 PRESET ACK  
44.04 TIME CODE PRESET ACK  
44.31 PRE-ROLL TIME PRESET ACK   
41.33 SERVO REFERENCE SELECT ACK   

N/A TIMER MODE STATUS ACK  
7X.20 STATUS DATA 7X.20  
N/A COMMAND SPEED SENSE 71.2E  

40.48 REF VIDEO SELECT ON ACK   
40.49 REF VIDEO SELECT OFF ACK   

6X.0E CURRENT TIME SENSE  ACK  
     

ACK= 10.01  NAK=11.12.xx 
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Odetics® Protocol 
Odetics serial protocol is an extension of P2 tape machine control protocol.  Among its most 
significant features is the selection of a file by name rather than by time-code location, as with 
P2.  Odetics protocol is used by many table -top controllers, and some automation systems.  Its 
implementation in the Image Server appears in the following table.  

ACK = 0X1001 

COMMAND DESCRIPTION RETURN COMMENT 

0X1001    
0X000C   LOCAL DISABLE  ACK  
0X0011   DEVICE TYPE 0X1211 BVW-75 
0X001D   LOCAL ENABLE ACK  
0X2000   STOP ACK  

0X2001   PLAY ACK  
0X2002   RECORD ACK  
0X2004   STAND BY OFF ACK  
0X2005   STAND BY ON ACK  
0X200D   DMC START ACK COMMAND HAS NO EFFECT 

0X200F   EJECT ACK  
0X2010   FAST FORWARD ACK  
0X2X11   JOG FORWARD ACK  
0X2X12   VAR FORWARD ACK  
0X2X13   SHUTTLE FORWARD ACK  

0X2020   REWIND ACK  
0X2X21   JOG REVERSE ACK  
0X2X22   VAR REVERSE ACK  
0X2X23   SHUTTLE REVERSE ACK  
0X2030   PREROLL ACK  

0X2X31   CUE UP ACK  
0X2X38   PROG SPEED PLAY PLUS ACK  
0X2X39   PROG SPEED PLAY MINUS ACK  
0X2052 TENSION RELEASE ACK COMMAND HAS NO EFFECT 
0X2054   ANTI CLOG TIMER DISABLE ACK COMMAND HAS NO EFFECT 

0X2055   ANTI CLOG TIMER ENABLE ACK COMMAND HAS NO EFFECT 
0X2X5C   DMC SET FORWARD ACK COMMAND HAS NO EFFECT 
0X2X5D   DMC SET REVERSE ACK COMMAND HAS NO EFFECT 
0X2060   FULL EE OFF ACK  
0X2061   FULL EE ON ACK  
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0X4X00   TIMER1 PRESET ACK  
0X4X04   TIME CODE PRESET ACK  

0X4008   TIMER1 RESET ACK  
0X4010   IN ENTRY ACK  
0X4011   OUT ENTRY ACK  
0X4X14   IN PRESET ACK  
0X4X15   OUT PRESET ACK  

0X4018   IN SHIFT PLUS ACK  
0X4019   IN SHIFT MINUS ACK  
0X401A   OUT SHIFT PLUS ACK  
0X401B   OUT SHIFT MINUS ACK  
0X4020   IN RESET ACK  

0X4021   OUT RESET ACK  
0X402D   LOST LOCK RESET ACK  
0X4X30   EDIT PRESET ACK COMMAND HAS NO EFFECT 
0X4X31   PRE-ROLL TIME PRESET ACK  
0X4X32   TAPE AUTO SELECT ACK  

0X4X33   SERVO REFERENCE SELECT ACK  
0X4X34   HEAD SELECT ACK COMMAND HAS NO EFFECT 
0X4X35   COLOR FRAME SELECT ACK COMMAND HAS NO EFFECT 
0X4X36   TIMER MODE SELECT ACK  
0X4X37   INPUT CHECK ACK  

0X4040   AUTO MODE OFF ACK  
0X4041   AUTO  MODE ON ACK  
0X4046   VARIABLE MEMORY OFF ACK  
0X4047   VARIABLE MEMORY ON ACK  
0X4048   VIDEO REFERENCE DISABLE OFF ACK COMMAND HAS NO EFFECT 

0X4049   VIDEO REFERENCE DISABLE ON ACK COMMAND HAS NO EFFECT 
0X4X70   VIDEO INPUT SELECT ACK  
0X4X91   OUTPUT VIDEO LEVEL ACK COMMAND HAS NO EFFECT  
0X4X92   OUTPUT SETUP BLACK LEVEL ACK COMMAND HAS NO EFFECT 
0X4X93   OUTPUT CHROMA LEVEL ACK COMMAND HAS NO EFFECT 

0X4X98   OUTPUT H PHASE ACK COMMAND HAS NO EFFECT 
0X4X99   OUTPUT SC PHASE ACK COMMAND HAS NO EFFECT 
0X4X9A   OUTPUT VIDEO HUE  ACK COMMAND HAS NO EFFECT 
0X6X0A   TC GEN DATA SENSE   

                    GEN TIME DATA 0X7408  

      GEN UB DATA 0X7409  
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      GEN U BAND TC DATA 0X7809  
0X600C   CURRENT TIME SENSE   

      CORRECTED LTC TIME DATA 0X7414  
      VITC TIME DATA 0X7406  
      TIMER1 DATA 0X7400  
      HOLD USER BITS LTC DATA 0X7415  
      HOLD USER BITS VITC DATA 0X7416  

0X6010   IN DATA 0X7410  
0X6011   OUT DATA 0X7411  
0X6012   A IN DATA NAK  
0X6013   A OUT DATA NAK  
0X6020   STATUS DATA 0X7420  

0X6X23   SIGNAL CONTROL DATA 0X7423  
0X602E   COMMAND SPEED DATA 0X712E  
0X602F   VAR MEM SPEED DATA 0X712F  
0X6X30  EDIT PRESET DATA NAK  
0X6031   PREROLL TIME DATA 0X7431  

0x6036   Timer Mode Status 0X7136  
0XA001  AUTO SKIP ACK ODETICS COMMAND 
0XAX02   CUE UP TO RECORD ACK ODETICS COMMAND 
0XAX04   PREVIEW IN PRESET ACK ODETICS COMMAND 
0XAX05   PREVIEW OUT PRESET ACK ODETICS COMMAND 

0XA006   PREVIEW IN RESET ACK ODETICS COMMAND 
0XA007   PREVIEW OUT RESET ACK ODETICS COMMAND 
0XAX10   ERASE ID ACK ODETICS COMMAND 
0XA014  LIST FIRST ID 0X8814 ODETICS COMMAND 
0XA015   LIST NEXT ID 0X8814 ODETICS COMMAND 

0XAX18   ID STATUS REQUEST 0X8818 ODETICS COMMAND 
0XA01C   MAXIMUM STORAGE LENGTH 0X891C ODETICS COMMAND 
0XAX20   SET DEVICE ID ACK ODETICS COMMAND 
0XA021   DEVICE ID REQUEST 0X8821 ODETICS COMMAND 
0XCX01     JUMP FORWARD X FRAMES ACK ODETICS COMMAND 

0XCX02     JUMP BACK X FRAMES ACK ODETICS COMMAND 
0XCX03     GET LOADED ID ACK ODETICS COMMAND 
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Appendix C 

Technical Specifications 
Video 
Input Channels (baseband) One 

Output Channels Three  

Analog video I/O Composite, 75Ω, BNC 

Digital video I/O SDI, SMPTE 259M, 75Ω BNC 

Video standards 525/60 NTSC; 625/50 PAL (Model dependent) 

MPEG recording formats MPEG-2: 4:2:2 Profile @ Main Level to 50 Mb/s 
MPEG-2: Main Profile @ Main Level to 15 Mb/s (4:2:0) 

DV playback format Option: playback of 25 Mb/sec DV files imported via Ethernet. 

Graphics playback format Option: playback of TARGA files with key & fill imported via 
Gigabit Ethernet. 

Word Size 10 bits dithered to 8 

Frame format I-frame, 6-GOP, 14 GOP 

Minimum pre-roll 10 frames 

Video sync reference (Genlock) External black burst or internal crystal 

Audio 
Digital Inputs/Outputs 2 stereo pairs (4 channels) per video input or output 

Digital audio format AES/EBU, 110-ohm, XLR-3 connector (AES-3-2000) 

Dynamic range (digital) 144 dB (24-bit word size) 

Audio format 48k sample rate, 24-bit word size, Linear PCM 

Embedded audio 20-bit, 4-channel. Optional software. 

Bit-for-Bit® data handling Transparent to Dolby®-E, Dolby AC-3 

Analog Inputs/Outputs 2 mono channels per video input or output 

Analog audio format Balanced, +4 dBu, XLR-3 connector 

Frequency response 10 Hz – 20 kHz ±0.1 dB 

Harmonic distortion <0.002% THD+N at full scale –1 dB 

Dynamic range 112 dB (24-bit word size) 

Headroom 20 dB above nominal +4 dBu operating level 

Audio sync reference Derived from video reference 

Time Code 
LTC In External time code, > 10k Ω BNC connector 
LTC Out External time code, Z = 750Ω, BNC connector 
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VITC line number, NTSC Field 1: Lines 14, 16; Field 2: Lines 277, 279 

VITC line number, PAL Field 1: Lines 19, 21; Field 2: Lines 332, 334 

Closed Captions 
Closed Captions Records and plays CC data per EIA -608B 

Control Inputs 
Automation control, RS -422 VDCP; 3 ports, 9-pin female “D” connector 

Other serial control, RS-422 P2, Odetics, AMX®, Crestron™ 

GPI control inputs/outputs 6 optically isolated inputs, 6 open-collector outputs, 25-pin 
female “D” connector 

Video Networking 
File interchange formats MXF (SMPTE 377M, 378M, 381M ); OP-1a, OP-1b; MPEG-2 

program streams (ingest) & elementary streams; DV stream 
(.dv or .avi); TARGA graphics import.  

Network port Gigabit Ethernet 

File transfer protocol FTP 

Disk Storage 
Storage time (max) 170 hours max at 12 Mb/s 

Capacity 480 GB to 1.6 TB 

Data redundancy Hardware-generated RAID-5 utilizing 4 drives 

Drive arrangement Located within enclosure, accessible behind front panel  

CD-ROM drive Internal, replaceable from front panel.  (For loading operating 
system and feature upgrades.) 

Miscellaneous 
Operating system Linux® 

Front panel indicators 5 LEDs indicate Power-on, Genlock, Fan alarm, Drive alarm, 
System alarm 

Miscellaneous ports Keyboard, mouse, SVGA display 

Cooling/Operating Temperature Forced air; Ambient operating temperature 10º to 35º C 

Power 100 – 240 VAC, 50/60 Hz, 2.0 amp max. Shut down switch on 
front panel; hard AC mains switch on rear panel 

Physical  
Mechanical  3½” x 19” x 18.5” (89 x 483 x 470 mm) H-W-D  

Mounting Rack mount (2U), optional adjustable rear supports 

Weight 28 lb. (12.7 Kg) 

Agency approvals UL, C-UL, FCC Class A, CE 

Country of origin U.S.A. 
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Keyboard Shortcuts 

Transport Control  Edit Operations 
L Forward at 4x, 16x, 64x, 128x  E Enter/Exit Edit Mode 

K Pause (Stop)  I Capture Mark In 

J Reverse at 4x, 16x, 64x, 128x  O Capture Mark Out 

Space Bar Play/Pause (toggle)  Shift+R Review Edit 

R Record  Shift+T Review Tail 

Home GoTo Head point   

End GoTo Tail point  Playlist 
Shift+E E/E Toggle  Home Recue 

Shift+L Loop Toggle  Space Play/Pause 

Shift+C Local Toggle  K Stop 

Shift+J Eject Clip   

Right Arrow Jog forward 1 frame  Playlist Edit 
Left Arrow Jog reverse 1 frame  Shift+C Clear 

   Left Arrow  << (Remove clip) 

File Operations  Right Arrow >> (Add clip) 

Ctrl+N New   

Ctrl+O Open  Navigating Between Channels 

Ctrl+S Save  Ctrl+<number> 
Switches to Transport 
Channel <number> 

Ctrl+A Save As  Alt+<number> 
Switches to Playlist  
Channel <number> 

Ctrl+D Delete   

Ctrl+R Rename  Mark In/Mark Out Times (Edit Mode) 
  <number> Inserts right justified number

Menu Operations  DEL Removes last digit 

Alt+F Expands File Menu  ESC Aborts time code entry 

Alt+T Expands Transport Menu  .  ;  :  (any) Shifts time code left 

Alt+C Expands Configure Menu  TAB 
Toggles between Mark In  
and Mark Out times 

Alt+P Expands Playlist Menu    

Alt+W Expands Window Menu    

Alt+H Expands Help menu    
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Appendix D 

Mechanical Drawing 

Figure 39: Dimensional Drawing 
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360 Systems 
Customer Service..................................... 112 
E-mail..................................................... 112 
Fax......................................................... 112 
Telephone .............................................. 112 
Website.................................................. 112 

4:2:0 ............................................................86 
4:2:2 ............................................................86 
About (Software Version) ................................30 
About RAID 5 ...............................................89 
Address, 360 Systems................................... 112 
AES/EBU....................... 11, 13, 22, 23, 119, 130 
Air Vent Slots ................................................18 
Analog Audio................................................22 
Analog Video................................................22 
Analog/Digital Audio Selection ..................... 108 
Animation Import ..........................................53 
Applications ..................................................14 
Audio Card 

A/D Jumper Location..................................23 
Audio Delay..................................................88 
Audio Format Labels ......................................23 
Audio I/O .....................................................22 
Audio Level Calibration................................ 109 
Audio Selection 

Analog/Digital ...........................................23 
Audio SRC ....................................................85 
Audio Sync Reference ....................................86 
Audio Word Size...........................................23 
Auto E-E Mode ........................................ 37, 73 
Automation Control .......................................71 
Automation Protocol ......................................71 
Available Models...........................................15 
AVI Files................................................54, 100 
Bit-for-Bit® ....................................................86 
Button 

|<, >|....................................................38 
|<–>|.............................................. 46, 69 
–>|................................................... 47, 69 
E-E ...........................................................37 
Eject.........................................................37 
FF 38 
GoTo .......................................................38 
Jog - .........................................................38 
Jog + .......................................................38 
Mark In Point ...................................... 45, 68 
Mark Out Point ................................... 46, 68 
Play..........................................................37 
Record .....................................................36 
Review Clip........................................ 46, 69 
Review Out Point ................................ 47, 69 
Rew .........................................................38 
Stop (Still) .................................................37 

Calibration 

Audio Level ............................................ 109 
Cascade Windows .........................................30 
CD-ROM .................................................... 111 
CD-ROM Drive .............................................19 
Channel Status Bar.........................................35 
Channels Menu ....................................... 29, 77 
Clip 

Exit...........................................................35 
Open .......................................................32 
Save..............................................33, 34, 35 
Save As.....................................................34 

Clip Transport Window..................................31 
Close Clip............................................. See Exit 
Color Framing ...............................................79 
Configuration Menu 

Cascade....................................................30 
Channels ............................................ 29, 77 
Date/Time........................................... 29, 77 
System................................................ 29, 76 

Connector Pinout 
Audio XLR-3 ........................................... 119 
GPI ........................................................ 120 
Serial Control .......................................... 119 
SVGA..................................................... 122 

Connectors ............................................. 21, 22 
BNC....................................................... 120 
Specifications .......................................... 119 

Constant Bit Rate ...........................................86 
Control Ports 

Priority ............................................... 36, 71 
Serial.................................................. 23, 71 

Current Time Code ........................................36 
Customer Service......................................... 112 
CVBS .....................................22, 24, 38, 78, 85 
Date/Time............................................... 29, 77 
Digital Audio .......................................... 22, 23 
Disk 

Percent Full...............................................32 
Disk Array 

Managing .................................................90 
Repair ......................................................90 

Dolby-E ........................................................86 
Drawing 

Mechanical ............................................. 133 
Rear Panel .......................................... 21, 22 

Drive Sizes......................................................9 
Drives 

LED........................................................ 104 
Drop Frame ..................................................81 
Duration Display ................................46, 47, 69 
DV and TARGA File Option ...........................15 
DV Stream Files......................................54, 100 
Editing 

Clip.................................................... 45, 68 
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While Recording .......................................45 
E-E Mode ......................................................37 
Eject Button ..................................................37 
Encode Mode ................................................86 
Ethernet Cable............................................. 101 
Ethernet Ports 

Gigabit ..............................................24, 101 
EULA ......................................................... 117 
Exit...............................................................35 
Exit Menu .....................................................29 
Factory Defaults ............................................84 
Fans LED .................................................... 104 
Fast Forward / Rewind Buttons ........................38 
Fault Diagnostics ......................................... 104 

LEDs .................................................20, 104 
File 

Exit...........................................................35 
New.........................................................32 
Open .......................................................32 
Save..............................................33, 34, 35 
Save As.....................................................34 

File Menu .....................................................29 
Exit ..........................................................29 

Front Panel 
Removing ............................................... 105 

Front Panel Features.......................................20 
Front Panel Indicators................................... 104 
FTP File Transfer.....................................54, 100 
Genlock 

LED........................................................ 104 
Signal Quality ...........................................24 
Sync Reference..........................................24 

Genlock Timing....................................... 77, 79 
Genlock Timing Tab ......................................77 
GoTo Buttons ................................................38 
GPI Input Assignment.....................................80 
GPI Output Assignment ..................................81 
Graphics and Animation.................................53 
Halt........................................................ 27, 91 
Handling Precautions ................................... 106 
Hard Drive 

Replacement ........................................... 112 
I/O Card 

Accessory ............................................... 107 
RAID...................................................... 107 
Video..................................................... 107 

Image Server 
Audio A/D Selection ..................................23 
Audio I/O .................................................22 
Connectors ......................................... 21, 22 
Indicators..................................................20 
Models .....................................................15 
Mounting ..................................................18 
Rear Panel .......................................... 21, 22 

Video In ...................................................22 
Video Out.................................................22 

In Point Display ....................................... 45, 68 
Indicators......................................................20 
Input 

Factory Defaults ........................................84 
Input Source..................................................85 
Inputs 

Audio.......................................................22 
Video.......................................................22 

Installation ....................................................17 
Installing Hard Disk Drives.............................96 
Installing/Removing 

I/O Cards ................................................ 107 
Introduction ....................................................9 
Jog Buttons....................................................38 
Jumpers 

A/D Audio Selection ................................ 108 
Location on Audio Card .............................23 

Key Features..................................................13 
Keyboard...............................................25, 122 
Keyboard Shortcuts .............132, See Appendix C 
KVM Switch..................................................17 
LED Indicators ............................................. 104 
LTC Source ...................................................86 
LTC Time Code 

Input ........................................................25 
Output .....................................................25 

Main Menu ...................................................28 
Main Profile ..................................................86 
Maintenance ............................................... 104 
Maintenance Spares.......................................16 
Mark In Point Button ................................ 45, 68 
Mark Out Point Button ............................. 46, 68 
Mechanical Concerns................................... 106 
Mechanical Drawing .................................... 133 
Menu 

Configuration ............................................29 
File ..........................................................29 
Main ........................................................28 
Transport ..................................................29 
Window ...................................................29 

Monitor ........................................................25 
Motherboard............................................... 107 
Mounting ......................................................18 
Mouse ...................................................25, 122 
MPEG-2 File Formats ..............................54, 100 
MPEG-2 Profile..............................................86 
MXF.............................................................98 
Network 

Cable ..................................................... 101 
Config Settings........................................ 101 
DHCP .................................................... 103 
Manual DNS ........................................... 103 
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Redundancy ............................................ 101 
Transfer Marked Segment ...........................98 
Transfer Rate .............................................98 

Networking ...................................................98 
Odetics 

Serial Control ............................................71 
Odetics® Protocol ........................................ 127 
On-Screen 

Configuration Menu ...................................29 
File Menu .................................................29 
Main Menu ...............................................28 
Transport Menu .........................................29 
Window Menu ..........................................29 

Operations ....................................................27 
Out Point Display .................................... 46, 69 
Outputs 

Audio.......................................................22 
Video.......................................................22 

P2 
Command Table...................................... 125 
Serial Control ............................................71 

Phase 
Color Framing ...........................................79 
Sub-Carrier................................................87 

Pinout 
GPIO ..................................................... 121 

Play Button ...................................................37 
Playback 

Concurrent................................................75 
Playing 

Clip..........................................................43 
Playlists, Seamless .........................................75 
Power Connector...........................................25 
Power LED.................................................. 104 
Power ON/OFF Button...................................20 
Power Sources...............................................25 
Program Updates 

CD-ROM ................................................ 111 
Protocol ........................................................71 
Rack Mounting ..............................................18 
Radio Interference Compliance ..................... 113 
RAID 

Card ....................................................... 107 
Fault Tolerance..........................................89 
Performance ..............................................89 
Repair ......................................................90 

Rear Panel 
Drawing ............................................. 21, 22 
Features.............................................. 21, 22 
Indicators................................................ 105 

Reboot .........................................................27 
Record 

Button ......................................................32 
Setup........................................................76 

Record Button ...............................................36 
Recording 

New.........................................................32 
Regulatory Compliance ................................ 113 
Repair ........................................................ 112 
Replacing a Hard Drive................................ 112 
Restart ..........................................................27 
Review Clip Button.................................. 46, 69 
Review Out Point Button.......................... 47, 69 
Sample Rate Conversion.................................85 
Save..................................................33, 34, 35 
Save As.........................................................34 
SC/H Phase ...................................................87 
Schematic 

GPIO ..................................................... 121 
SDI .................................. 9, 13, 22, 38, 85, 130 
Serial Control Ports ........................................23 
Serial Protocol 

Command Table...................................... 123 
P2 125 
VDCP..................................................... 123 

Service 
Access .................................................... 105 
Front Panel ............................................. 105 
Top Cover............................................... 105 

Shutdown ............................................... 27, 91 
Shuttle..........................................................38 
Slider Bar......................................................38 
Software License Agreement ......................... 117 
Software Version ......................................... 111 
Specifications 

Connectors ............................................. 119 
Technical ................................................ 130 

SRC..............................................................85 
Still ...........................................See Stop Button 
Still Frames...................................................55 
Stop (Still) Button...........................................37 
Storage Capacity..............................................9 
Sub-Carrier Phase ..........................................87 
SVGA Connector Pinout ............................... 122 
Symbols 

Warning And Information .............................7 
Sync Reference 

Genlock ...................................................24 
System 

Timing Tab ...............................................78 
System Board Ports ...................................... 122 
System LED................................................. 104 
System Menu .......................................... 29, 76 
TARGA File Ingest .........................................53 
TARGA Files..........................................54, 100 
Time 

System................................................ 29, 77 
Time Code 
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Burn-In .....................................................87 
LTC ..........................................................25 
Type................................................... 77, 81 
VITC ........................................................86 

Timing Tab ...................................................78 
Top Cover 

Removing ............................................... 105 
Track Arming ................................................85 
Transfer Rate 

Ethernet....................................................98 
Transport Menu .............................................29 
Trouble Shooting ................ See Fault Diagnostics 
Variable Bit Rate............................................86 
VDCP 

Command Table...................................... 123 
Controllers .......................................... 73, 75 

Serial Control ............................................71 
VDCP Options ..............................................72 
Vertical Interval Time Code ............................86 
Video Format ................................................79 
Video I/O Card............................................ 107 
Video Inputs .................................................22 
Video Outputs...............................................22 
Video Sync ...................................................77 
VITC ............................................................86 
Warranty .................................................... 115 
Window Burn ...............................................87 
Window Menu ..............................................29 
Wiring 

GPIO Schematic...................................... 121 
XLR-3 Connectors ..........................................22 
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